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1. Student Aid Internet Gateway (SAIG) System Overview 
Through the SAIG, you can send, receive, and manage Federal student aid information 
electronically. By linking your computer to the resources of various Title IV Application 
System databases and processing services, the SAIG helps you manage Title IV 
Federal Student Aid (FSA) information efficiently. 
In December 2019, Congress passed the Fostering Undergraduate Talent by Unlocking 
Resources for Education Act (FUTURE Act), which amends Section 6103 of the Internal 
Revenue Code (IRC) to allow the Internal Revenue Service (IRS) to disclose certain 
Federal Tax Information (FTI) to FSA. The FTI-SAIG system is used specifically to 
transmit Institutional Student Information Record (ISIR) files containing sensitive FTI 
data. FTI-SAIG users have the ability to send and receive files while maintaining 
complete compliance with IRS Publication 1075 requirements regarding the transfer and 
storage of FTI data.  

 TDNgine (TDN) — TDN is a bTrade Commercial-off-the-shelf (COTS) 
product that is the “engine” of the SAIG application.  This application is 
used as the mailbox application for sending, storing, retrieving, and 
archiving data. TDN resides on FSA’s servers located at the Next 
Generation Data Center (NGDC). 

 TDClient — TDClient is a client-side bTrade COTS product used to send 
and receive data securely over the Internet.  This software is command-line 
based and does not have a user interface.  TDClient resides on the end 
user’s computer or server. 

 TDCommunity Manager (TDCM) — TDCM, also known as SAIG Portal, is 
a web-based bTrade COTS product that allows users to manage their 
mailboxes and to view data transmissions history to and from mailboxes.  
This product does not send or receive data. 

 FTI-TDCommunity Manager (FTI-TDCM) — FTI-TDCM, also known as 
FTI-SAIG Portal, is a web-based bTrade COTS product that allows users to 
manage their mailboxes and to view data transmissions history to and from 
mailboxes. This product does not send or receive data. 

 EDconnect — EDconnect is a custom client-side software product used to 
send and receive data transmissions securely over the Internet.  This 
software presents a graphical user interface for users to send and receive 
data. EDconnect is coded in the C++ language and utilizes the TDClient 
Windows Application Programming Interface (API). The software is 
installed on the client’s standalone PC or in a workstation/network server 
environment. 

Using software provided for the SAIG/FTI-SAIG, you collect data on your personal 
computer (PC) or computer system and transmit the collected data in batches over the 
SAIG/FTI-SAIG. The appropriate Title IV Application System receives the data, 
processes the data, performs any required database cross-referencing, and returns the 
processed data to your mailbox. In addition to providing a summary of the services 
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available through the SAIG/FTI-SAIG, this guide gives detailed instructions on the 
installation of EDconnect.  
A Help component is available within the EDconnect software. To see a list of available 
topics, select Help Topics from the EDconnect Help menu. Both the installation guide 
and EDconnect online Help are designed to address the needs of non-technical users, 
although a working knowledge of Windows and the ability to perform basic PC 
operations are assumed. 
By enrolling in the SAIG/FTI-SAIG, you have become a “destination point.” FSA 
provides the EDconnect software to make it possible for you to send and receive data 
through the SAIG/FTI-SAIG. In addition, FSA makes other programs and documentation 
available for additional Title IV Application Systems in which you may have enrolled. 
The EDconnect 8.6.1 upgrade permits retrieval of Federal Tax Information (FTI) data 
from you FTI-SAIG mailbox if you have one; existing functionality to SAIG mailboxes is 
unchanged.  
 
Note: SAIG/FTI-SAIG term is used throughout the guide and refers to both systems, it 
is important to keep in mind that FTI-SAIG and SAIG are NOT the same system.
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1.1  Store and Forward Data Transmissions  
Once enrolled through the Participation Enrollment (PM) system, a Destination Point is 
assigned a SAIG electronic mailbox. Using the EDconnect client-side software, 
destination points can transmit data with Title IV Application Systems securely over the 
Internet to/from their assigned electronic mailbox. The figure below illustrates the data 
flow between a destination point and Title IV Application System using electronic SAIG 
mailboxes: 
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1.2 Destination Point Administration  
A Destination Point Administrator (DPA) is an individual representing an organization 
involved in the administration of Title IV student financial aid programs (such as a 
postsecondary institution, FFELP lender, FFELP guaranty agency or third-party 
servicer) that is enrolled in the SAIG/FTI-SAIG and assigned a Destination Point (TG/FT 
number/mailbox). The administrator is responsible for the security of data obtained 
through the SAIG/FTI-SAIG. The administrator controls access to the SAIG/FTI-SAIG 
through a particular destination point by setting the levels of access to EDconnect and 
the SAIG/FTI-SAIG for each user. The administrator also maintains SAIG/FTI-SAIG 
User Statements (see Appendix A) for all users of the SAIG/FTI-SAIG at a particular 
destination point. 
 
1.2.1 For Security Groups  
Security Groups share a common TG (for non-FTI users) or FT (for FTI users) number, 
a common Connection Type (“Production” or “Test” for TG numbers, “FTI” for FT 
numbers), a common SAIG/FTI-SAIG password, common access to EDconnect 
features, and common access to the SAIG/FTI-SAIG.  
Security Groups can be especially useful for institutions that have separate FT/TG 
numbers for services such as COD (Pell and/or Direct Loan), CPS, and NSLDS. You 
can also create more than one Security Group for the same FT/TG number. Changing 
the password for one Security Group changes the password for all other Security 
Groups accessing the same FT/TG number and using the same Connection Type. 
When a user within a Security Group connects to the SAIG/FTI-SAIG, the user connects 
with the FT/TG number and SAIG/FTI-SAIG password for that group. The individual 
user’s name will appear in the Activity Log for each Send or Receive record. 
The Destination Point Administrator is responsible for controlling the varying levels of 
access among the Security Groups set up in EDconnect by managing SAIG/FTI-SAIG 
passwords, SAIG/FTI-SAIG access, and SAIG/FTI-SAIG connections at the group level. 
 
1.2.2 For Users  
Users represent individuals within Security Groups sharing common access to 
EDconnect and the SAIG/FTI-SAIG. The Destination Point Administrator is responsible 
for controlling each user’s level of access to EDconnect and the SAIG/FTI-SAIG at the 
group level. User IDs are issued by FSA. 
When a user connects to the SAIG/FTI-SAIG and sends or receives data, the user’s 
name will appear in any Send or Receive record in the User Name column of the 
Activity Log. Startup options, color preferences, and file folder locations are established 
at the user level. User passwords are issued by FSA. 
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1.3 SAIG/FTI-SAIG User Statement 
A copy of the SAIG/FTI-SAIG User Statement is shown in Appendix A. This statement 
may be copied. The Destination Point Administrator should have signed copies of this 
statement on file for each EDconnect user.  
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2. Installing EDconnect  
This section contains detailed instructions for downloading and installing EDconnect. 
Instructions are provided for both stand-alone and network installations. 
The latest EDconnect 8.6.1 software is compatible with both IPv4 and IPv6 connections. 
If a user is unaware as to whether they have access to an IPv6 connection, we 
recommend contacting your IT department who will be able to provide this information. 
EDconnect 8.6.1 is available for SAIG/FTI-SAIG users to download from the FSA 
Knowledge Center website (https://fsapartners.ed.gov/knowledge-
center/topics/software-and-other-tools/edconnect). 
 

2.1 Hardware and Software Requirements 
EDconnect 8.6.1 requires a connection to the Internet. You must have a connection to 
the Internet.  Please contact your IT department if you are unsure how to connect to the 
internet. This connection must be active (i.e., you must be connected to the Internet) to 
use EDconnect. 
To comply with ED requirements, your personal computer must meet or exceed the 
following minimum configuration: 

 IBM or fully IBM-compatible PC with a 1.2 GHz processor. 
 512 MB RAM memory. 
 60 GB hard drive. 
 Windows compatible keyboard and mouse. 
 SVGA graphics adapter capable of 800 X 600 screen resolution or higher. 
 56 kbps analog using V.90 and Internet connection. 
 Windows 10 or higher, or Windows Server 2012 or higher. 

https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-tools/edconnect
https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-tools/edconnect
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2.1.1 Estimating Hard Disk Space Needs  
 
The software takes up the following space on your hard disk: 
 

Product Size 

EDconnect 15 MB 

EDExpress 16 MB 

SSCR with 300 records 6 MB 

 
Each set of 5,000 records requires the following space: 

Record Size 
Direct Loan 49 MB 

ISIR 16 MB 

NSLDS 7 MB 

Packaging 3 MB 
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2.1.2 Supported Operating Systems 
EDconnect can be used as stand-alone or as multi-user software and can be installed 
on the following Operating Systems:  

 Windows 10 or higher 
In multi-user mode, the EDconnect database (edconn.mdb) can also reside on the 
following supported network operating systems:  

 Windows Server 2012 or higher 
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2.2 Important Installation Notes 
Before you start the installation, be sure to close all Windows applications, including 
screensavers, e-mail notification programs, and antivirus software. 
Installing EDconnect creates default folders and subfolders to manage the transfer of 
files between different Title IV financial aid software packages and to simplify file 
management. ED recommends that you use these default folders.  
You must be an Administrator on your workstation to install EDconnect 8.6.1. If you are 
not an Administrator, you will receive a warning when you try to install EDconnect. 
There are no workarounds for these Windows rights issues. Please consult with your 
organization’s technical department if you receive a warning that an Administrator must 
install the EDconnect software. 
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2.3 Downloading Software/Paper Documentation 
You can download both software and paper documentation from the FSA Knowledge 
Center website (https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-
tools/edconnect). The amount of time it takes to download a file depends on the file size 
and the speed of your Internet connection.  
Some organizations block their employees from downloading programs from Internet 
sites. If you have problems downloading from the FSA Knowledge Center website, try 
again later. If you continue to experience problems, contact your technical support staff 
to ensure that you have full download rights. 
Electronic documentation is available to view/download from the Internet in Adobe PDF 
format. The following types of paper documentation are available for you to download: 

 Installation and User Guides  
Each link to the above electronic document is accompanied by a description that 
includes the date the document was posted and the size of the file.  

1. Type the FSA Knowledge Center Web address, 
https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-
tools/edconnect, into the address box at the top of your browser window. 

2. Click on the “EDconnect 8.6.1” link to access the EDconnect software and 
document links. 

3. Click on the link for “Subject: EDconnect Installation and User Guide” to access 
the applicable page containing the documentation links. 

4. Click on the “EDconnect Installation and User Guide” link. 
5. A PDF version of the document shall display in your browser to view or 

download. 

2.3.1 Downloading the Software 
The installation package for EDconnect 8.6.1 is available on the FSA Knowledge Center 
website.  Follow the steps below to download the EDconnect 8.6.1 software: 
 

1. Type the FSA Knowledge Center web address, 
https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-
tools/edconnect, into the address box at the top of your browser window. 

2. Click the link for “EDconnect 8.6.1” under “By Version Number 
3. Click the link to the left of “Subject: EDconnect Download for Windows”. 
4. Next, click “EDconnect Download for Windows” to download the file to your 

PC’s default location or, right click and select “Save link as…” to save to another 
location on your hard drive. The Windows Desktop is a convenient place to save 
the file and locate it later. Click the Save button. The length of time it will take the 
file to download depends on the speed of your Internet connection. See the table 
of download times in this section. 

https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-tools/edconnect
https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-tools/edconnect
https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-tools/edconnect
https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-tools/edconnect
https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-tools/edconnect
https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-tools/edconnect
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Note:  
 It is recommended that SAIG/FTI-SAIG users download the installation file 

to a folder other than the one in which you will install EDconnect. For 
example, users may create a folder called “FSA SAIG Downloads,” 
specifically for the installation files you download from the FSA Knowledge 
Center. 

 Once you have downloaded the installation file to your hard drive, go to the 
folder containing the EDconnect860.exe file and double-click it to start the 
installation. Go to the Installing EDconnect section of this guide for further 
instructions. 
 

 Downloading the software does not install it. 
 

 You should have no other programs running while you are installing 
EDconnect. 



                                                                                                             Installing EDconnect 

 

February 24 EDconnect 8.6.1 User Guide  12 

2.4 Installing EDconnect 
Follow the steps below to install EDconnect 8.6.1. 

1. Close any programs that are running, including antivirus software. 
2. Locate the EDconnect861.exe download file and double-click on it to start the 

installation. 
Note: You may receive the following User Account Control prompt.  Click Yes to 
proceed. 

 

 
Users may see a notification that the Microsoft C++ 2013 and/or 2015 
redistributable package(s) are pending install.   
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If you already have the redistributable installed, you will not see this notification, 
but if you see it, click Install.    
Once the redistributable is installed, the EDconnect installation process begins, 
and a splash screen briefly appears: 

 
 
The splash screen will automatically close, and a “Preparing Setup” screen will 
be shown briefly. After a few seconds, the Welcome screen appears. 

 

 
 

3. Select the Next button and the Installation Type dialog box will open. 
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4. User will be prompted to select the type of installation: Local Install, Local 

Install - Custom, Network Install, or Workstation Install. 
Note: To view a description of the installation types, click on an option to 
highlight and the description will display at the bottom of the dialog box.  
Please read the explanation of each installation type option below: 
 Select Local Install if you are installing EDconnect, including the 

EDconnect database, on a single PC for the first time. By selecting Local 
Install, you will install all EDconnect components, including the database, 
to your local hard drive. 
 
Note: The EDconnect software defaults to Local Install when prompted to 
select an install option. 

 If you already have an EDconnect database on your local hard drive. 
select Local Install - Custom. By selecting Local Install - Custom, you will 
install all EDconnect components except the database to your local hard 
drive. 

 Select Network Install if you do not have an existing EDconnect database 
in a network location and want multiple PCs to have common access to a 
single EDconnect database. Performing a Network Install places the 
EDconnect database (EDconn8.mdb) on your Local Area Network (LAN). 
The EDconnect database contains the information users will share, such 
as the Activity Log and Security View information. 
 
Note: A Network Install does not install the program itself. After a Network 
Install, you must perform a Workstation Install on each PC to install the 
program files. Record the location of the EDconnect database when 
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performing a Network Install. You will need this information when 
performing the Workstation Install. 

 
 Select Workstation Install if you already have an EDconnect database on 

your network. Perform a Workstation Install on each PC that you want to 
access the EDconnect database. 

 
Note: You must perform a Network Install before performing a Workstation 
Install if the EDconn8.mdb database is not already on your network. The 
Workstation Install checks for a valid EDconnect database in the selected 
network location before proceeding. 

5. Select the type of installation by clicking once on the option and then on the Next 
button. The Destination Folder dialog box will appear on your screen. 
Depending on your operating system, the default destination folder is 
C:\Program Files (x86)\EDconnect8 for a local installation. Make note of where 
the destination folder is. 
Note: For a network installation, you will need to select the appropriate LAN drive 
as the database location. You can accept the default folder or change the 
destination folder by using the Browse button. 
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6. Select Next and the Database Setup dialog box will appear on your screen. This 

dialog box enables you to enter a new location for the EDconnect database or 
accept the default location. 
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7. Select Next and the Select Program Folder dialog box will appear on your 

screen. This dialog box enables you to enter a new folder name, select an 
existing folder, or accept the default folder name of EDconnect 8.6.1. 
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8. Select Next and the System Information dialog box will appear on your screen. 

This dialog box provides information about your computer system. You can 
ignore this information; or verify it against the minimum system requirements in 
the Hardware and Software Requirements section of this guide. 
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9. Select Next and the Install Settings dialog box will appear, confirming that setup 

has enough information to begin copying files to your PC. If you want to review or 
change any of the settings, click on the Back button to return to the appropriate 
dialog box. 
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10. Select Next. A progress bar appears, showing you the progress of files being 

copied to your hard drive. When the installation is finished, EDconnect will open 
a window containing icons for the program and for Transmission Queue 
templates. 

       
Note: If you want to create a shortcut to EDconnect on your Desktop, right-click 
on the EDconnect icon and select Send To from the menu, then select Desktop 
(create shortcut). 
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11. Click Finish. The installation program will ask you to restart your computer. 

 

 
 
Helpful Hints 

 The EDconnect database contains a record of data transfers but does not 
physically contain any of the files you have sent or received. All files you 
have sent or received are stored in a separate location and are unaffected 
by the EDconnect database. Other databases you may have on your 
computer, such as the EDExpress, or SSCR databases, are also 
unaffected by the EDconnect database. 

 During the installation, EDconnect creates several Transmission Queue 
(TQ) template icons in the EDconnect Program Group. These icons enable 
quick access to commonly used default TQ template files. If you select one 
of these icons, EDconnect will start and will automatically fill in the 
Transmission Queue with the appropriate data requests. For example, 
selecting the all.tqt icon starts EDconnect and places a request in the 
Transmission Queue for all data and all messages currently in your 
mailbox. 

 You can drag or copy these TQ icons, along with the EDconnect icon, to 
your desktop from the icon window that appears at the end of the 
installation. 



                                                                                                             Installing EDconnect 

 

February 24 EDconnect 8.6.1 User Guide  22 

2.5 Setting Up EDconnect 
The following instructions will lead you through the steps necessary to setup EDconnect 
8.6.1. These instructions assume that you have installed EDconnect 8.6.1 for the first 
time.  
EDconnect users will also need to obtain an FT/TG Number, FSA User ID, FSA User 
Password and Security Token from FSA prior to beginning set up. The Security 
Token is a physical token (or a software-based token) that you will use to generate a 
One-Time Password to enter the Security Code field.  
Note: You must be connected to the Internet before you start EDconnect. 
 

1. Start EDconnect. When you run EDconnect for the first time, a startup 
information dialog box will appear.  This contains warnings about using 
EDconnect and both critical and non-critical issues. Click OK to close this dialog  
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2. Log in to EDconnect. After you accept the warnings, a Security Authentication 
dialog box will appear with the default group name of “FSA Administration 
Group” already selected.  Enter your FT/TG Number, FSA User ID, FSA User 
Password and Security Code, if applicable, and click OK.  

                        
 You will immediately see the “Tip of the Day” dialog box. Click OK to close 

the dialog. 
  
              

             
 

 
3. Create an FSA Administration Group Profile. EDconnect will then prompt you 

to create the profile of the FSA User ID you logged in with. The User Wizard will 
guide you through this.  
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4. Create a Security Group. Only an FSA User ID in the FSA Administration 
Group can create other security groups. To create a security group, right click on 
the EDconnect folder in the Security View and choose Insert. The Group 
Wizard will lead you through the tabs of the Group Properties dialog box. The 
Group Properties settings control your access to the SAIG/FTI-SAIG, as well as 
each user’s access within a group. The FSA Administration Group cannot 
conduct transmissions and therefore does not have a password field in the 
Network tab. Once your FSA Administration Group is created, you will need to 
create the required security groups for your institution to transmit. 

 
5. Perform a Local Only password change. During the initial setup of your non-

Administration security group, EDconnect will prompt you for a new SAIG/FTI-
SAIG password. The first step in establishing your password is to perform a 
Local Only password change. 

 
 If you are installing EDconnect to access a new SAIG/FTI-SAIG mailbox, 

the initial password is set as follows: “ccyynnnn” where “ccyy” is your birth 
year and “nnnn” represents the last four digits of your social security 
number. Enter your initial password as the Local Only password. Go to 
Step 7. 

 If you are installing EDconnect to access an existing SAIG mailbox you 
have been accessing with an earlier version of EDconnect, enter the 
password you used in the previous version as the Local Only password. 
Under these circumstances, you do not need to perform a Network and 
Local password change. Skip to Step 8. 

 If you have already performed a Local Install of EDconnect on another 
computer in your office and have transmitted a SAIG/FTI-SAIG password 
from that computer, enter that SAIG/FTI-SAIG password as a Local Only 
password change. Under these circumstances, you do not need to perform 
a Network and Local password change. Skip to Step 8. 

6. Change your SAIG/FTI-SAIG password. After you perform a Local Only 
password change, you must perform a Network and Local password change to 
establish your password on the SAIG/FTI-SAIG. When you change your 
SAIG/FTI-SAIG password, be sure to select Network and Local. This adds a 
password change record to the Transmission Queue. EDconnect will transmit 
the password change the next time you connect to the SAIG/FTI-SAIG. 

7. Set up a personal FSA User ID. After you set up your FSA Administration 
Group profile, you will need to set up your FSA User ID. To create a new user, 
select the group name, right click, and select Insert. The User Wizard will lead 
you through the tabs of the User Properties dialog box. 
 When you set up an FSA User ID, you will notice a small box on the User 

Profile box labeled “Unattended Transfer User ID?”. If you will be sending 
.imp files with this user ID, you will need to check this box to allow the user 
this permission.  
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 Note: Unattended users will not display in the dropdown list of the Security 
Authentication screen and will not be able to log in.  It is not recommended 
that you make an FSA User ID into an unattended user.  See Section 
5.3.13 Unattended Transfer User ID and .imp Files for more detailed 
information about setting up unattended users. 

 Note: FT mailboxes cannot be used in unattended mode. 
 

–  
 
8. Download the message class table. Message class tables “teach” EDconnect 

what kinds of files it can send and receive. These tables are placed periodically 
into your SAIG mailbox. Your mailbox will contain the latest message class table. 
When you connect to the SAIG, it will automatically download to your PC and 
import into EDconnect.   
 Note: Users will need to connect quarterly after the updates. 

9. Coordinate global file paths for sending and receiving files. EDconnect does 
not automatically create paths for sending and receiving data. If you do not 
specify Send and Receive paths, EDconnect will use the paths listed in the 
Filename field of the Message Class Manager. 
 You can change the paths on the Directories tab of the User Properties 

dialog box. Right-click the FSA User ID you wish to edit and select 
Properties from the pop-up menu. Click the Directories tab. At the top of 
the tab, a drop-down list will enable you to select Database, Send, or 
Receive.  

 The Database path will reflect the current location of the EDconnect 
database, but the Send and Receive paths will be blank. Select Send or 
Receive, then type in the full path, including drive letter, or use the Browse 
button to find the correct folder. 



                                                                                                             Installing EDconnect 

 

February 24 EDconnect 8.6.1 User Guide  26 

 Be sure to enter a location for both the Send and Receive folders. If you 
would like to use the same setting for all existing users in a specific group, 
place a check in the box marked “Set all users of this group to the specified 
directories.” 
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2.5.1 Setting up a Test Security Group (SAIG users only) 
If you have been advised to do so, EDconnect 8.6.1 enables you to set up a test 
Security Group to send and receive files from the SAIG test system without interfering 
with your production Security Group(s). See Section 3.4 Security Groups for further 
information about setting up a test Security Group.   
 
NOTE: This does not apply to FTI-SAIG users. 
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2.5.2 Selecting a Connection  
EDconnect 8.6.1 uses the Internet to access the SAIG/FTI-SAIG. You will need to be 
connected to the Internet before you can login to EDconnect. Your Internet connection 
to the SAIG/FTI-SAIG has no relationship to the dial-up connection used by earlier 
versions of EDconnect. 
The first FSA User ID to login after setup that is not in the FSA Administration Group 
will be prompted to set a connection. This only needs to be done once.  

2.5.2.1 Setting up the Connection When Prompted 
 

1. Start EDconnect and login via the Security Authentication screen as a new 
first time FSA User. You will then receive a message that indicates a 
connection must be selected to transmit.  Click OK. 
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2. If you select No, skip to Section 3.6.1 Selecting a Connection for details on 
how to setup the connection later. Note that you cannot transmit until this 
connection is set up.  If you choose yes, you will get the Connection Properties 
dialog box. 

 
 

 
 
 

 The drop-down list in the Connection to use selection box displays a list of 
Internet connections available on your computer. If you have a direct 
connection to the Internet, such as DSL, T1, or cable, “Direct Connection” 
may be the only option listed. If you connect to the Internet using a modem 
and an Internet Service Provider (ISP), in most cases your ISP’s dial-up 
connection will appear on the list. 

 
3. After selecting your connection, click the Test button. You will receive a 

confirmation message.  
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2.5.2.2 Setting up the Connection Without Prompts 
If you opted No at the prompt, or want to set the connection later, follow these steps. 
Remember that if you do this while logged in under FSA Administration Group, you will 
not be able to access the Transmission Wizard or run a transmission test.  
 

1. Select Tools from the EDconnect main bar menu, then Customize. You should 
see the Connection Properties dialog box.  

 
 

 
 

 The drop-down list in the Connection to use selection box displays a list 
of Internet connections available on your computer. If you have a direct 
connection to the Internet, such as DSL, T1, or cable, “Direct Connection” 
may be the only option listed. If you connect to the Internet using a modem 
and an Internet Service Provider (ISP), in most cases your ISP’s dial-up 
connection will appear on the list. 
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2. After selecting your connection, click the Test button. You will receive a 
confirmation message.  

 
 

 
 

3. You will not receive the Transmisson Wizard at this point. You can however, 
test the transmission connection at any time by choosing Test under the 
Transmission menu in the main EDconnect menu bar. 

 
 
2.5.2.3 Firewalls 
A firewall is a barrier between your computer or your Local Area Network (LAN) and an 
external source, such as the Internet. The barrier can be software, hardware, or a 
combination of the two. A firewall examines each packet of information coming into and 
going out of your computer and prevents unauthorized packets from being sent or 
received. 
A port is a pre-defined “channel,” numbered from 0 to 65535, used by your computer to 
send and receive specific kinds of data. Your computer usually sends and receives e-
mail through port number 25 and makes standard Internet connections through port 
number 80. 
A firewall can prevent EDconnect from communicating with the SAIG/FTI-SAIG by 
blocking the packets of information your computer is trying to send to and receive from 
the SAIG/FTI-SAIG. If you have trouble connecting to the SAIG/FTI-SAIG after installing 
EDconnect 8.6.1, contact your technical support staff to see if you are behind a firewall. 
“Error -1” usually means that the port used by EDconnect to send and receive data is 
blocked. Your technical support staff will need to open port number 26581 for inbound 
and outbound TCP/IP traffic and give your computer access to saigmailbox.ed.gov 
and fsaesb.ed.gov to enable EDconnect to communicate through the firewall to the 
legacy SAIG and new FTI systems. 
In order to use the TDCM or FTI-TDCM, you need to be able to connect to 
https://saigportal.ed.gov/tdcm (SAIG system) and  https://ftisaigportal.ed.gov/tdcm 
(FTI-SAIG system) and will need port number 443  open. Information about using the 
TDCM or FTI-TDCM is available in the SAIG/FTI-SAIG Mailbox Software & Manuals: 
EDconnect, TDClient, TDCM and FTI-TDCM section on the FSA Knowledge Center 
Web website (https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-
tools/edconnect). 

https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-tools/edconnect
https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-tools/edconnect
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2.5.2.4 Getting Help  
For help installing or using EDconnect, contact the SAIG/CPS Help Desk at 800-330-
5947 or by e-mail at CPSSAIG@ed.gov. 
 



                                                                                                             Using EDconnect 

 

February 24 EDconnect 8.6.1 User Guide  33 

3. Using EDconnect 
3.1 Destination Point Administration 
The Destination Point Administrator (DPA) is the “owner” of the SAIG/FTI-SAIG mailbox 
and is responsible for security within EDconnect. The DPA creates and controls 
Security Groups and the users within those groups through the Security View. 
Security Groups share a common FT/TG number, a common Connection Type 
(“Production” or “Test” for SAIG users, “FTI” for FTI users), a common SAIG/FTI-SAIG 
Password, and common access to the SAIG/FTI-SAIG. The main purpose of 
separating users into groups is to regulate user access within EDconnect. Groups can 
also be useful for dividing functions among users. Folder icons represent Security 
Groups in the Security View. 
Users are individuals within Security Groups who share a common access to 
EDconnect and the SAIG/FTI-SAIG. 

 Each FSA User ID has its own FSA User Password. The DPA should 
have a signed SAIG/FTI-SAIG User Statement on file for each user.  

 When you enroll through the SAIG/FTI-SAIG Enrollment Site 
(fsawebenroll.ed.gov), you are required to print the SAIG/FTI-SAIG User 
Statement as part of the online enrollment process.  

 You should retain the statements at your institution for auditing purposes. 
 
Helpful Hints 

 You control SAIG/FTI-SAIG Passwords at the group level. 
 FSA controls and issues access to EDconnect. 
 You control startup options, color preferences, and file directory locations 

at the user level. 
 FSA User IDs can belong to multiple groups in the Security View. 
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3.2 Security Authentication for User Logons 
An FSA User ID can belong to several different Security Groups within EDconnect. 
This method enables a single user to send and receive data using different FT/TG 
numbers and Connection Types (“Production” or “Test”).  
EDconnect utilizes Two-Factor Authentication (TFA) to authenticate a user. User IDs 
and passwords are issued by FSA. Access to EDconnect requires a Group ID, FT/TG 
Number, FSA User ID, FSA User Password, and a Security Code. All FSA Users 
IDs will be required to enter a Security Code.  

 FSA will issue your institution a Security Token. This is a physical token 
that will generate a One-Time Password that is required to log into 
EDconnect. 

 Each group can be associated with a different FT/TG number.  
 If a user belongs to more than one group, the EDconnect Security 

Authentication dialog box enables the user to select the group to log in 
under for that session. 

In the illustrations below, the FSA User ID “peter.pdpa.fsa” belongs to both the “FSA 
Administration Group” and the “FISAP” group. He can login to the software under either 
group.  
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The Security Code field is where a user will enter the One-Time Password generated 
by a physical token or a software-based token that is issued by FSA. This token must 
be registered through FSA. To register a token, select the Register/Maintain Token 
button on the Security Authentication screen.  Users will then be routed to the Login - 
AIMS TFA Portal. 
If you have forgotten your token and cannot generate the One-Time Password, you 
can reset it by selecting the Forgot Token button on the Security Authentication screen. 
Users will then be routed to the Login - AIMS TFA Portal. 
If you have forgotten your password, you can reset it by selecting the Forgot Password 
button on the Security Authentication screen. Users will then be routed to the Change 
Password website. 
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3.3 Security View  
The Security View controls user access to EDconnect. This view enables you to set up 
Security Groups as well as to create individual users within those groups.  

 You control SAIG/FTI-SAIG Passwords at the group level. 
 FSA controls and issues access to EDconnect. 
 You control startup options, color preferences, and file directory locations 

at the user level. 
 FSA User IDs can belong to different groups in the Security View. 
 An illustration of an EDconnect Security View is shown below: 

 

                                    



                                                                                                             Using EDconnect 

 

February 24 EDconnect 8.6.1 User Guide  37 

In the example below, “FSA Administration Group”, “FISAP” and “COD” represent 
Security Groups, while the individual names below the group names signify users 
within those groups. 
 

 
 
 
There are three methods to move a user to another group. 
Only a user belonging to the FSA Administration Group can move a user to another 
group by dragging and dropping the FSA User ID. 
To drag and drop an FSA User ID 

1. Select the FSA User ID by pressing your left mouse button to highlight it. 
2. Move your cursor over the group into which you want to drop the FSA User ID. 
3. Release the mouse button. 

Any FSA Administrator or Group user has the functionality to copy one user from one 
group to another group.  
To copy an FSA User ID 

1. Click on the FSA User ID you want to copy. 
2. Select Copy from the Edit menu. 
3. Click on the group to which you want to copy the FSA User ID. 
4. Select Paste from the Edit menu.  

Any FSA user can delete another user and re-insert that user into another group, unless 
the deleted and re-inserted user is a member of the FSA Administration Group.   
Delete and Re-Insert 
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1. Click on the FSA User ID you want to copy. The FSA User ID will appear 
highlighted. 

2. Click with the right mouse button and select Delete from the pop-up menu and 
click yes to the “Delete User?” message. 

3. Click with the right mouse button on the Group you want to add the FSA User ID 
to and select Insert from the pop-up menu 

4. Use the User Wizard to recreate the deleted FSA User ID. 
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3.4 Security Groups 
Within EDconnect, a Security Group represents a collection of users who connect to 
the SAIG using the same FT/TG number, the same Connection Type (“Production” or 
“Test”), and the same SAIG/FTI-SAIG Password. 
An institution can have one or more Security Groups with varying levels of access to 
EDconnect functions.  
Security Group names often correlate to the group’s function, i.e., FISAP, COD, CPS, 
etc.  
Connection type can be set either by the current user or will be prompted to the first 
non-Administration user to login. See Section 3.6.1 Selecting a Connection for more 
detail. 
Only an FSA Administration Group user can create or delete groups, as well as 
modify group FT/TG Numbers. The FSA Administration Group is a permanent group 
and cannot be deleted. 

3.4.1 To add a “Production” or “FTI” Security Group 
1. Open the Security View by selecting New from the File menu and selecting 

Security View from the list of views. You can also click the Security View button 
on EDconnect’s main toolbar. 

2. Right-click on the EDconnect folder. 
3. Select Insert from the pop-up menu. The Group Wizard will appear on your 

screen.
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4. Complete the General Information screen by providing a group name. Click 
Next. 

 



                                                                                                             Using EDconnect 

 

February 24 EDconnect 8.6.1 User Guide  41 

5. Set up access rights for all the users in the group by completing the Access 
Rights screen. Click Next. 
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6. Set up SAIG/FTI-SAIG Password information for the group by completing the 
SAIG/FTI-SAIG Information screen. Leave the Connection Type set to the 
default value “Production” for TG users, and “FTI” for FT users. 

 

 
7. Click Finish. 
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3.4.2 To add a “Test” Security Group (SAIG only) 
If you have been advised to set up a test Security Group to access the SAIG test 
system, follow the steps above but in step 6 select “Test” as the Connection Type on 
the Information tab.   
NOTE: Test Security Groups do not apply to the FTI-SAIG system, only to the SAIG 
system. 
Helpful Hints 

 You can also access the Group Wizard by highlighting EDconnect in the 
Security View and selecting Insert Record from the Record menu. 

 Multiple groups can have access to the same FT/TG number, but they 
cannot have the same group name. For example, groups ‘FISAP’ and 
‘COD’ can both have access to TGA0376, but you cannot have two groups 
named ‘FISAP’.  
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3.4.3 To delete a Security Group 
You must be logged in as a user of the FSA Administration Group to delete a Security 
group. 

1. Open the Security View by selecting New from the File menu and selecting 
Security View from the list of views. You can also click the Security View button 
on EDconnect’s main toolbar. 

2. Right-click on the EDconnect folder. 
3. Select Delete from the pop-up menu. 
4. Verify confirmation message, “Delete the group COD and all users within this 

group?" and select yes. 
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3.4.4 To Modify a Security Group  
You must be logged in as a user of the FSA Administration Group to modify a 
Security group. 

1. Open the Security View by selecting New from the File menu and selecting 
Security View from the list of views. You can also click the Security View button 
on EDconnect’s main toolbar. 

2. Right-click on the EDconnect folder. 
3. Select Properties from the pop-up menu. 
4. Verify the Group Properties dialog box open, displaying the Group Properties 

screen with the group name visible.  
 

 
 

5. From this screen, you can select which tab you need to make your modifications. 
Click Apply and then OK when you are finished.  



                                                                                                             Using EDconnect 

 

February 24 EDconnect 8.6.1 User Guide  46 

3.5 Users  
Within EDconnect, users represent the individuals within Security Groups who access 
the SAIG through that group’s FT/TG number. You add users to Security Groups in 
the Security View.  Users must be added using an FSA User ID.  FSA User IDs and 
FSA User Passwords are issued by FSA.  
By default, any FSA User ID can create and delete other users, except those in the 
FSA Administration Group.  

3.5.1 To add an FSA User ID 
1. Open the Security View by selecting New from the File menu and selecting 

Security View from the list of views. You can also click the Security View button 
on EDconnect’s main toolbar. 

2. Right-click on the Security Group to which you want to add a user. 
3. Select Insert from the pop-up menu. The User Wizard will appear on your 

screen. 

 
4. Complete the information on the Identification tab. Click Next. Remember that 

all user IDs must be FSA User IDs, or they will not be allowed access to 
EDconnect. For more on the ‘Unattended Transfer User ID’ box, see Helpful 
Hints below. 

5. Change the defaults, if desired, on the General Information tab. Click Next. 
6. Change the default directory settings, if desired, on the Directory Settings tab. 

The drop-down menu (above the Browse button) enables you to set the path for 
the EDconnect database, the Send path, and the Receive path. Click Next. 

7. Choose your color preferences. Click Next. 
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8. Choose your printing preferences. 
9. Click Finish. 

Helpful Hints 

 The password you establish through the Group Wizard is associated with 
your FT/TG number and enables your destination point to connect to the 
SAIG/FTI-SAIG. 

 All user IDs must be FSA User IDs, otherwise they will not be allowed 
access to EDconnect. 

 The ‘Unattended Transfer User ID’ box is to be checked only when the 
FSA User ID will be sending .imp files. When this box is checked, the FSA 
User ID will not show up in the drop down of the Security Authentication 
dialog box. For more on .imp files, see section 5.1.1 Import (.imp) Files. 

  
3.5.2 To delete an FSA User ID 

1. Open the Security View by selecting New from the File menu and selecting 
Security View from the list of views. You can also click the Security View button 
on EDconnect’s main toolbar, highlighted here. 

 
 

2. Right-click on the Security Group to which you want to delete a user. 
3. Select Delete from the pop-up menu. 
4. Verify confirmation message, “Delete the user harry.potter.fsa?” 

                          

 
 

5. Click Yes. 
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3.5.3 To Modify an FSA User ID  
1. Open the Security View by selecting New from the File menu and selecting 

Security View from the list of views. You can also click the Security View button 
on EDconnect’s main toolbar. 

2. Right-click on the Security Group to which you want to modify a user. 
3. Select Properties from the pop-up menu. 
4. Verify the User Properties dialog box appears. 

 
 

5. Select the tab where you want to make the modification, (In this example, the Full 
Name field will be modified.) 
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6. After your modification is made, click Apply, and OK.  
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3.6 SAIG/FTI-SAIG Test Connection  
This section provides guidance to users who wish to perform a TEST connection to 
confirm whether EDconnect is able to connect to their mailbox and transfer files. You 
must be connected to the Internet before starting EDconnect. 
If you have questions about using the Transmission Wizard, please contact CPS/SAIG 
Technical Support at 1-800-330-5947 or by email at cpssaig@ed.gov. 
 
3.6.1 Selecting a Connection 
There are two methods to select your connection.  
Method 1 - The first FSA User ID that is not part of the FSA Administration Group will 
be prompted to choose a connection upon initial login.  

 

 
1. Click OK.  You will be prompted to select one from the Connection Properties 

dialog box. 
 

mailto:cpssaig@ed.gov
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2. (Optional) Click Test to test the connection you have selected. You will receive a 

“Test completed successfully!” message. 

 
3. Click OK. 
4. If this is your initial login or set-up, the Transmission Wizard will appear. You 

can run this test now or choose to skip it by checking the “I want to skip this 
test” box. (Not recommended). You can also test your connection at any time by 
selecting ‘TEST’ from the Transmission menu at the top of the screen. 
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Method 2 - The second is a manual selection. 

1. Select Customize from the Tools menu. 
2. Select the Connection tab on the Properties dialog, if not already selected. 
3. Select a connection from the drop-down list in the Connection to use selection 

box. See Important Notes, below, for information about selecting a connection. 
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4. (Optional) Click Test to test the connection you have selected. You will receive a 

“Test completed successfully!” message. 
 

 
5. Click OK. 
 
6. If this is your initial login or set-up, the Transmission Wizard will appear. You 

can run this test now or choose to skip it by checking the “I want to skip this 
test” box. (Not recommended). You can also test your connection at any time by 
selecting ‘TEST’ from the Transmission menu at the top of the screen. 
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7. During the transmission test the window will look like these screenshots: 
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8. Upon successful completion of the transmission test it will show: 
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3.7 Firewalls  
A firewall is a barrier between your computer or your Local Area Network (LAN) and an 
external source, such as the Internet.  

 The barrier can be software, hardware, or a combination of the two.  
 A firewall examines each packet of information coming into and going out 

of your computer and prevents unauthorized packets from being sent or 
received. 

A port is a pre-defined “channel,” numbered from 0 to 65535, used by your computer to 
send and receive specific kinds of data. Your computer usually sends and receives e-
mail through port number 23 and makes standard Internet connections through port 
number 80. 
A firewall can prevent EDconnect from communicating with the SAIG by blocking the 
packets of information your computer is trying to send to and receive from the SAIG.  
 
Determining If You Are Behind a Firewall 
If you have trouble connecting to the SAIG/FTI-SAIG after installing the new version of 
EDconnect, contact your technical support staff to see if you are behind a firewall. “Error 
-1” usually means that the port used by EDconnect to send and receive data is blocked. 
Your technical support staff will need to open port number 26581 for outbound TCP/IP 
traffic and give your computer access to saigmailbox.ed.gov and fsaesb.ed.gov  to 
allow EDconnect to communicate through the firewall. 
If you have trouble logging into the FTI-SAIG after installing the new version of 
EDconnect, contact your technical support staff to see if to saigmailbox.ed.gov and 
fsaesb.ed.gov are currently blocked by your organization’s IT department.  
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3.8 Wizards  
EDconnect contains several wizards that assist you in your initial setup of the software. 
The following table describes each of the wizards: 

Wizard Name Function Access 
Group Wizard Prompts you for all 

necessary 
information to set up 
a security group. 

Select Yes, when 
prompted, to update a 
group. 
Choose to insert a 
group in the Security 
View. 

User Wizard Prompts you for all 
necessary 
information to set up 
a user. 

Select Yes, when 
prompted, to update a 
user. 
Choose to insert a user 
in the Security View. 

FTI-SAIG 
Connection 
Wizard 

Prompts you to 
select a connection 
to use to send and 
receive data. 

Select Yes, when 
prompted, to select a 
connection. 

FTI-SAIG 
Transmission 
Wizard 

Conducts a brief test 
to see if EDconnect 
is able to send and 
receive files. 

If you have not 
completed the test, this 
wizard automatically 
appears on your screen 
after you log into 
EDconnect. 
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4. Passwords 
4.1 Types of Passwords 
EDconnect requires three different types of passwords: FSA User Passwords, 
Security Codes, and SAIG/FTI-SAIG Mailbox Passwords.  
Each user must enter an FSA User Password and Security Code to log into the 
software. The Security Code is a One-time Passcode (OTP) auto generated by a 
security token that FSA has provided to the user after the PM enrollment process has 
been completed.  EDconnect uses the SAIG/FTI-SAIG Password (also known as your 
SAIG/FTI-SAIG mailbox password) to connect to the SAIG/FTI-SAIG. EDconnect also 
requires a certificate for authentication to AIMS, in order to transmit data. 
After you have established your SAIG/FTI-SAIG Password, you do not need to enter it 
to transmit. EDconnect stores the SAIG/FTI-SAIG Password and sends it automatically 
each time you connect to the SAIG/FTI-SAIG. 

4.1.1 FSA User Password and One-Time Password (OTP) 
 FSA User Passwords are issued by FSA. 
 To change your password, select the Forgot Password button on the 

Security Authentication screen. Users will then be routed to the Change 
Password website and guided through the process.  

 



                                                                                                                            Passwords 

 

February 24 EDconnect 8.6.1 User Guide  59 

4.1.2 SAIG/FTI-SAIG Password 
The SAIG/FTI-SAIG Password is independent of the EDconnect FSA User ID 
Password. The SAIG/FTI-SAIG Password is controlled at the group level and is the 
password for your mailbox.  
Users can set or change the SAIG/FTI-SAIG Password on the Network tab of the 
Group Properties dialog box. See Section 4.3 SAIG/FTI-SAIG Passwords for detailed 
instructions on how to change your SAIG/FTI-SAIG Password. 

4.2 FSA User Password 
Each user must enter an FSA User Password to log into the EDconnect software. 
Each FSA User ID in the EDconnect Security View has its own personal password. 
When you start EDconnect, the Security Authentication dialog box will appear. Enter 
or select your Group ID, FT/TG Number, and FSA User ID, assigned by FSA, from the 
drop-down list and enter the FSA User Password and your Security Code (one-time 
password).  
Note: EDconnect has specific rules for the FSA User Password: 
 The password must have a minimum length of 15 characters and must contain 

each of the following four types of characters  
o English uppercase letters (A-Z) 
o English lowercase letters (a-z) 
o Westernized Arabic numerals (0-9) 
o and non-alphanumeric special characters, specifically (!,@,#,$,&,*) 

 The password cannot contain any words that are easily guessed like dictionary 
words, names, or acronyms 

 The password must contain at least four (4) alphabetic characters, and 
 The password cannot contain three (3) or more identical characters in a row. 

 
Helpful Hints 

 If you still are unable to log into EDconnect, please contact the SAIG/CPS Help 
Desk at 800-330-5947 or by e-mail at CPSSAIG@ed.gov for assistance. 
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4.2.1 Changing Your FSA User Password 
FSA user passwords are managed by FSA through the AIMs website. You can access 
this website by selecting the Forgot Password button on the Security Authentication 
screen where you will be guided through the process of changing your FSA User 
Password.  

 
After you have successfully changed your password, return to the Security 
Authentication screen to login. 
Helpful Hints 

 All passwords in EDconnect are case-sensitive.  
 Be sure to use the same capitalization each time you type your FSA User 

Password. 
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4.3 SAIG/FTI-SAIG Password 
EDconnect uses the SAIG/FTI-SAIG Password (also called the Group Password, 
FT/TG Password, or Network Password) to access your SAIG/FTI-SAIG mailbox 
when you send or receive data.  
Note: Your “Production” SAIG password and your “Test” SAIG password are not in 
sync.  If you are unable to access the test environment, contact the SAIG/CPS Help 
Desk to have them reset your test password.  Passwords expire after 90 days. This is 
only applicable for SAIG users; FTI-SAIG users do not have access to the test 
environment.  
The SAIG/FTI-SAIG Password can be set or changed on the Network tab of the 
Group Properties dialog. 
EDconnect has specific rules for SAIG/FTI-SAIG passwords: 

 Must be a minimum length of 15 characters. 
 Must begin with an alpha character 
 Must contain at least two alpha characters of different cases 

(uppercase/lowercase) and at least one numeric character 
 Cannot be the word “PASSWORD” (uppercase, lowercase, or mixed case) 
 Cannot be the same as any of the previous 24 passwords 
 Password will be locked out after three failures. (You must wait 15 minutes 

for your password to be unlocked.  After 15 minutes, you can try again.  If 
you have forgotten your password.  

 Can contain special characters 
 SAIG/FTI-SAIG passwords can contain special keyboard characters, such 

as @, #, and $, but because some computer platforms use certain special 
characters as command characters, we recommend avoiding % (percent), 
^ (caret), & (ampersand), \ (backslash), / (forward slash), < (less than), > 
(greater than), and | ("pipe" symbol). 

All passwords in EDconnect are case-sensitive. SAIG/FTI-SAIG Passwords expire 
every 90 days.  
The SAIG/FTI-SAIG Password is tied to a destination point’s FT/TG number and 
Connection Type (“Production” or “Test” for SAIG, “FTI” for FTI-SAIG). While each 
user of EDconnect has his or her own FSA User Password, there is only one 
SAIG/FTI-SAIG Password per FT/TG number and Connection Type. 
You can set up more than one Security Group with the same FT/TG number and 
Connection Type. Since these groups connect to the SAIG/FTI-SAIG with the same 
FT/TG number and Connection Type, they must use the same SAIG/FTI-SAIG 
Password.  
 

 

Helpful Hints 
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 Each FT/TG number/Connection Type combination has its own SAIG/FTI-
SAIG Password.  

 Each user of EDconnect has her or his own FSA User Password.  
 Users do not need to know the SAIG/FTI-SAIG Password to log into 

EDconnect or to transmit. 
 As the expiration date for your SAIG/FTI-SAIG Password approaches, you 

will receive a warning that the password is about to expire when you 
transmit with EDconnect. 
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4.3.1 Changing Your SAIG/FTI-SAIG Password 
You have two options for changing your SAIG/FTI-SAIG Password: Local Only and 
Network and Local.  
Your SAIG/FTI-SAIG Password is associated with your FT/TG number and 
Connection Type and is stored within EDconnect and on the SAIG/FTI-SAIG. Your 
SAIG/FTI-SAIG mailbox compares the password transmitted by EDconnect with the 
password stored on the SAIG/FTI-SAIG to confirm your group identity during each 
transmission.  

 A Local Only password change sets the password within EDconnect but 
does not transmit the password change to your SAIG/FTI-SAIG mailbox.  

 A Network and Local password change sets the password within 
EDconnect and transmits the change to your SAIG/FTI-SAIG mailbox. 

If you have had your SAIG/FTI-SAIG Password reset by the SAIG/CPS Help Desk, you 
must: 

1. Perform a Local Only password change, changing your SAIG/FTI-SAIG 
Password to the password assigned to you (uppercase and without the 
quotation marks). 

2. Perform a Network and Local password change to establish a new password on 
the SAIG/FTI-SAIG. 

If you reinstall EDconnect but have already established an SAIG/FTI-SAIG Password, 
a Local Only password change will synchronize the password within EDconnect to 
match the password stored by your SAIG/FTI-SAIG mailbox. 
Helpful Hints 

 All passwords in EDconnect are case-sensitive.  
 Be sure to use the same capitalization each time you type your SAIG/FTI-

SAIG Password. 
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4.3.2 Performing a “Local Only” SAIG/FTI-SAIG Password Change 
1. Open the Security View by selecting New from the File menu and selecting 

Security View from the list of views. You can also click the Security View button 
on EDconnect’s main toolbar. 

2. Right-click on the desired group within the Security View. 
3. Select Properties from the pop-up menu. 
4. Select the Network tab from the Group Properties dialog. 

 
5. Type your current SAIG/FTI-SAIG Password in the New text box. 

Note: If you are accessing a new SAIG/FTI-SAIG mailbox for the first time, the 
default password is an eight-digit number comprised of the year of the DPA’s 
birth and the last four digits of his or her Social Security Number. If you have had 
your password reset by the SAIG/CPS Help Desk, the new password is 
“PASSWORD” (uppercase and without the quotation marks) or some other 
assigned password. 

6. Type your password again in the Verify text box. 
7. Select the Local Only option under Change Type, if not already selected.  
8. Click OK. The message “Local FT/TG password changed” appears. 
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9. Click OK to return to the Security View. 
 

Helpful Hints 

 A Local Only password change sets the SAIG/FTI-SAIG Password within 
EDconnect without sending the password change to the SAIG/FTI-SAIG. 

 A Local Only password change is necessary after your password has 
been reset by the SAIG/CPS Help Desk, when you move EDconnect to a 
different PC, or when you install EDconnect on several PCs that share one 
FT/TG number and Connection Type but have separate EDconnect 
databases. 

 Your Local FT/TG password must match the SAIG/FTI-SAIG password to 
transmit successfully. 
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4.3.3 Performing a “Network and Local” SAIG/FTI-SAIG Password Change 
1. Open the Security View by selecting New from the File menu and selecting 

Security View from the list of views. You can also click the Security View button 
on EDconnect’s main toolbar. 

2. Right-click on the desired group within the Security View. 
3. Select Properties from the pop-up menu. 
4. Select the Network tab from the Group Properties dialog. 

 
5. Type your new SAIG/FTI-SAIG Password in the New text box. 
6. Type the password again in the Verify text box using the same capitalization.  
7. Select Network and Local as the Change Type, if not already selected.  
8. Click OK. The message “FT/TG Password change request added to 

Transmission Queue” appears. 

 
9. Click OK to return to the Security View. 

10. Select Now from the Transmission menu or select the ‘Transmit’ icon to send 
your new password to the SAIG/FTI-SAIG. 

Helpful Hints 



                                                                                                                            Passwords 

 

February 24 EDconnect 8.6.1 User Guide  67 

 Selecting a Network and Local change on the Network tab of the Group 
Properties dialog will create a password change request in the 
Transmission Queue. EDconnect will transmit the request the next time 
you send or receive data. 

 You need to perform a Network and Local password change every 90 
days or your SAIG/FTI-SAIG Password will expire. 

 

4.3.4 Changing your SAIG/FTI-SAIG Password After Help Desk Resets It 
1. Right-click on the desired group in the Security View. 
2. Select Properties from the pop-up menu.  
3. Select the Network tab from the Group Properties dialog. 
4. Type your assigned password in the New text box. 
5. Type your assigned password again in the Verify text box. 

 
6. Select Local Only as the Change Type, if not already selected.  
7. Click Apply. The message “Local FT/TG password changed” appears. 
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8. Click OK to respond to the message. The Group Properties dialog will stay on 

your screen. 
9. Type your new password in the New text box. 
10. Type the password again in the Verify text box using the same capitalization. 
11. Select the Network and Local option, if not already selected. 
12. Click OK. The message “FT/TG Password change request added to 

Transmission Queue” appears. 

 
13. Click OK to return to the Security View. 
14. Select Now from the Transmission menu or the ‘Transmit’ icon to send your 

new password to the SAIG/FTI-SAIG. 
 

4.3.5 Changing Your SAIG/FTI-SAIG Password After It Has Expired 
Your SAIG/FTI-SAIG Password expires every 90 days. You are warned that your 
SAIG/FTI-SAIG Password is due to expire nine days before the expiration date. The 
expiration date and warning period are set by the SAIG/FTI-SAIG network and cannot 
be modified. 
To access the Group Properties dialog 

1. Go to the Security View. 
2. Right-click on the desired group name.  
3. Select Properties from the pop-up menu. 
4. Select the Network tab to check the expiration date. 

If you attempt to connect to the SAIG/FTI-SAIG after your password has expired, a 
message box appears, indicating that your password has expired.  
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You do not need the SAIG/CPS Help Desk reset your password if you receive this 
message. The SAIG/FTI-SAIG will allow you to send and receive data as long as you 
transmit a password change.  
To change your SAIG/FTI-SAIG Password, click Yes which will launch the Group 
Properties dialog displayed on the next page. After you enter your new SAIG/FTI-
SAIG Password, try another transmission. EDconnect will send your password change, 
along with any other items in the Transmission Queue. 
Helpful Hints 

 If you have had your password reset by the SAIG/CPS Help Desk, the 
password of your SAIG/FTI-SAIG mailbox will be set to a temporary  
password which will be provided by the Helpdesk.  

 You must perform a Local Only password change, changing your 
password to the assigned password.  

 You must then perform a Network and Local password change to set your 
SAIG/FTI-SAIG Password to a password of your own choice. 

 
4.3.6 Important Note 
For enhanced security, your account will lock after three failed transmissions due to an 
expired or invalid SAIG/FTI-SAIG Password.  Users must wait a period of 15 minutes 
for the account to unlock or contact the SAIG/CPS Help Desk at 800-330-5947 for 
immediate assistance. 
The SAIG/CPS Help Desk must talk directly to the Destination Point Administrator 
(DPA) or Secondary Destination Point Administrator (SDPA) to verify personal 
identifiers before resetting your SAIG/FTI-SAIG Password or unlocking your account. 
The DPA or SDPA should be prepared to supply his or her Social Security Number 
(SSN) and date of birth (DOB). 
SAIG/FTI-SAIG Password Change Screen Example 
Illustration of the password change screen for the SAIG/FTI-SAIG Password: 
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5. Data Transmission 
Before you can transmit data in EDconnect 8.6.1, you must first download a Runtime 
certificate (RTM file) and tdclient.ini file from FTI-TDCM via http://ftisaigportal.ed.gov. 

5.1 Download Certificate (RTM file) from FTI-TDCM 
Login to FTI-TDCM (http://ftisaigportal.ed.gov) and navigate to the “Participant Tab”. 
Under the “Security” subtab, click on the “Export Runtime” button. Note the location 
where the Runtime (.RTM) file is saved, as well as the “Approval Code” shown in FTI-
TDCM, for use in the import step. 

 
To import the certificate for use by EDconnect, select the Import Certificate shortcut 
in the EDconnect 8.6.1 folder on the Start Menu. 

 
To complete the certificate import process, follow these steps as prompted: 

1. At the “Enter full pathname of the ‘rtm’ file from KeyManager” prompt, enter 
the path and filename of the runtime (.RTM file) that was downloaded from FTI-
TDCM. 

http://ftisaigportal.ed.gov/
http://ftisaigportal.ed.gov/
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2. At the “Enter output path for runtime files (128 char max)” prompt, enter the 

path to place the extracted runtime files.  Place the files under C:\IAM\SAIG_temp\ 
in the runtime folder under the folder that corresponds to the FT number for the 
user, as shown in the screenshot. 
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3. At the “Enter approval code if required (16 characters)”, enter the approval 
code for the certificate, which is obtained in FTI-TDCM.   
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4. The Import Certificate tool will show several details during the import, as shown in 
this screenshot. 
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5. After importing the RTM file, you can verify that the import was successful by 
selecting the “Check Certificate shortcut” in the EDconnect 8.6.1 folder on the 
Start menu. 
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6. At the prompt, enter the path to the installed runtime, under C:\IAM\SAIG_temp\ 
in a folder that corresponds to the FT number for the user, as shown in the 
screenshot. 
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7. The details of the certificate runtime will be shown, as follows. 
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5.2 Updating the tdclient.ini file  
Users must also download the tdclient.ini file from the participant security tab in FTI-
TDCM by clicking the “Export INI” button.   

 
Once the tdclient.ini file is downloaded, place it in the folder under C:\IAM\SAIG_temp\ 
that corresponds to the FT number for the user.  For example, for a user with FT 
number FTCZ519, the file would be placed as shown in this screenshot. 

 
After copying the tdclent.ini file to the proper location, open the file using Notepad or 
another editor of your choice, and make the following changes in the [FTISAIGPORTAL] 
section: 

DHONLY=N 
DATA_OVER_COMMAND=Y 
NOTE: These changes to the tdclient.ini file are critical to being able to transmit data 
in EDconnect 8.6.1. 

5.3 Sending and Receiving Data 



                                                                                                                Data Transmission 

 

February 24 EDconnect 8.6.1 User Guide  79 

5.3.1 Sending Data 
You send data to the SAIG for processing by creating files containing data, then adding 
the files to the Transmission Queue as Send requests.  
When EDconnect connects to your SAIG mailbox, it sends the files from your PC to the 
SAIG.  
The appropriate Title IV Application System picks up your files, processes them, and 
returns the processed data to your mailbox.  
Important Note: Non-FTI users are only able to send non-FTI data.  FTI users cannot 
send any data using EDconnect.
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5.3.2 Receiving Data  
You receive data by adding requests to the Transmission Queue.  
When EDconnect connects to your SAIG/FTI-SAIG mailbox, it retrieves the processed 
files placed in your SAIG/FTI-SAIG mailbox by a Title IV Application System and returns 
them to your PC.  FTI users are able to receive FTI data, while non-FTI users are only 
able to receive non-FTI data. 
Helpful Hint 

You can send (for non-FTI users) and receive (both FTI and non-FTI users) data as well 
as perform password changes during the same connection to the SAIG/FTI-SAIG. You 
must have a Message Class table imported before you can make a transmission. 
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5.3.3 Data Transmission Menu 
The Transmission menu on the main menu bar gives you three choices: Now, Later, 
and Test.  

 
 Selecting the Now option starts a connection to the SAIG immediately. All 

data queued for sending to the SAIG/FTI-SAIG and properly marked in the 
Transmission Queue are sent. All data queued for receiving from your 
mailbox and properly marked in the Transmission Queue are received, 
provided there are data files in your mailbox. 

 Selecting the Later option opens the Transmission dialog box that 
enables you to select a time and date for EDconnect to connect to the 
SAIG/FTI-SAIG. 

 Selecting the Test option transmits a test file to the SAIG/FTI-SAIG, then 
sends a request for the same file. EDconnect creates the test file, so you 
do not need to add it to the Transmission Queue before you perform the 
transmission test. The Test option will also send a SAIG/FTI-SAIG 
Password change if you have one in your EDconnect Transmission 
Queue. 
Helpful Hint: 
If you set up a later transmission, EDconnect must remain open until the 
time you select for the later transmission arrives. A message box tracks the 
time remaining until EDconnect transmits your data. 
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5.3.4 Transmission Queue (TQ) 
The Transmission Queue (TQ) is a list of pending requests to send or receive data 
and/or to make a password change. Below is a partial image of the Transmission 
Queue. 

 
Requests remain in the TQ until EDconnect processes them during a transmission or 
until you remove them from the TQ. 

 You can open the TQ by selecting New from the File menu and choosing 
Transmission Queue from the list of views.  

 You can also click the Transmission Queue button on EDconnect’s main 
toolbar. 

To add records manually to the TQ 
1. Move the cursor to the first blank line in the TQ. 
2. Complete each field either by typing your selection or by clicking the down arrow 

to display a menu of choices. 
3. Complete the rest of the fields for the same row. EDconnect does not let you 

move to a new row until you have completed all the necessary fields for the 
current row. 

4. You will know that a line is complete when the pencil symbol on the far left of the 
row disappears. The record is then ready for transmission. 

 
Below is an example of the pop-up dialog that appears when you select the down arrow 
in the File Name field.  

 This step is usually the final step in preparing a record in the TQ.  
 The Data File dialog that appears enables you to select the specific file 

that you want to send. 
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Helpful Hints 

 If you know the message class of a file you want to receive, typing the 
message class will fill in all necessary fields automatically. 

 If you want to receive all data and messages, go to the Description 
column, and select “All Data, All Messages” from the list. This action will fill 
in all necessary fields automatically. 
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5.3.5 TQ Templates 
5.3.5.1 Creating TQ Templates 
The Transmission Queue (TQ) is a list of pending requests to send or receive data or 
to make password changes.  
Records remain in the TQ until EDconnect processes them during a transmission, or 
until you remove them from the TQ. 
You can save a current view of the TQ and make that into a template file (TQT) that can 
be loaded back into the TQ later.  
To create a template, follow these instructions 

1. Create a group of records in the TQ that you plan to use repeatedly in the future. 
2. Select Save As… from the File menu. 
3. Choose a location to save the file and give it a name you will remember. As part 

of the file name, be sure to include the extension “.tqt” when naming the template 
file. 

4. Click OK. 
Helpful Hints 

 Templates are “snapshots” of a current view saved to a file.  
 Templates can be especially useful for common tasks.  
 Instead of manually creating the same records each time, you can load a 

template with the records already created. 
 

5.3.5.2 Opening TQ Templates 
You can retrieve saved “snapshots” of a Transmission Queue (TQ) view by opening 
Transmission Queue Template (TQT) files using one of the following methods: 

1. Select Open from the File menu within EDconnect and select the name of the 
TQT file. 

2. Use your mouse to drag the TQT file from Windows Explorer to an open TQ. 
3. Select a template from the All Programs| EDconnect8 menu. There are pre-

created templates in the EDconnect8 folder on the Programs menu. Selecting a 
template will open EDconnect8. 

Helpful Hints 

 EDconnect automatically places several common TQT files in the 
EDconnect directory during installation. 

 You cannot import TQT files associated with earlier versions of EDconnect 
into EDconnect 8.6.1. 
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5.3.6 Activity Log 
The Activity Log stores a record of all transmissions made using EDconnect.  
It lists files that have been sent and received, SAIG/FTI-SAIG Password changes that 
have been transmitted, and any transmission errors that occurred while sending or 
receiving files.  
You can open the Activity Log by selecting New from the File menu and selecting 
Activity Log from the list of views. 

 
5.3.6.1 Archiving Activity Log Records 

1. Open the Activity Log. 
2. Select the records you want to archive. 
3. Select Save As… from the File menu. 
4. Name the file, preserving the “.arc” extension. 
5. Select the drive and directory where you want to save the file. 
6. Click Save. 

Helpful Hints 

 You can select records easily using the Activity Log Filter. 
 Archiving records from the Activity Log does not automatically delete 

those records.  
 To delete records, return to the open Activity Log and highlight the 

records you archived. If you filtered the records, highlight all the records in 
that view. Press Delete. 

 
5.3.6.2 Retention Period 
The Retention Period dialog box enables you to set the length of time that EDconnect 
retains records in the Activity Log before automatically deleting them.  
To set the retention period 

1. Choose Properties from the Edit menu while the Activity Log is active on your 
screen. 

2. Select the Received File tab on the Properties dialog. 
3. Click Enable Automatic Delete to activate the delete function. 
4. Drag the vertical bar in the middle of the Retention field to set the number of 

days (the default is zero days). 
5. Click OK. 

Helpful Hints 
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 You can use your left and right Arrow keys to fine tune your selection.  
 Pressing the left Arrow key lowers the Retention Period by one day and 

pressing the right Arrow key increases it by one day. 
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5.3.7 Mailbox Query  
You can use the Mailbox Query to get a “snapshot” of the current contents of your 
SAIG/FTI-SAIG mailbox. After performing a Mailbox Query, you can place requests for 
specific files in your Transmission Queue.  

 
5.3.7.1 To use the Mailbox Query 

1. With no records selected for transmission or receipt in your Transmission 
Queue, select Now from the Transmission menu to connect to the SAIG. 

2. After the transmission completes, open the Mailbox Query by selecting New 
from the File menu and selecting Mailbox Query from the list of views. You can 
also click the Mailbox Query button on EDconnect’s main toolbar. 

3. Select the items you want to receive in the next transmission by putting a 
checkmark in the Move to TQ column. 

4. Close the Mailbox Query by selecting Close from the File menu. This places a 
request in the Transmission Queue for each file that you selected. 

Helpful Hints 

 At the end of each transmission, EDconnect updates the Mailbox Query to 
reflect what is currently in your SAIG/FTI-SAIG mailbox.  

 If you receive all the data in your mailbox, the Mailbox Query will be empty 
because your mailbox is empty.  

 To get a “snapshot” of the current contents of your SAIG/FTI-SAIG 
mailbox, follow the steps above to perform a new Mailbox Query. 
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5.3.8 Received File View  
The Received File View lists the files that you have recently downloaded.  
This view displays files that you have downloaded from your SAIG/FTI-SAIG mailbox 
over the previous ten days. 

 
You can download files listed in the Received File View without having the files 
restored by the SAIG/CPS Help Desk.  

5.3.8.1 To re-download files 
1. Open the Received File View by selecting New from the File menu and 

selecting Received File View from the list of views. 
2. Place a checkmark in the Move to TQ checkbox to the left of the batch you want 

to restore. 
3. Close or save the Received File View. Once the Received File View is closed 

or saved, each record that you selected is added to the Transmission Queue. 
4. Select Now from the Transmission menu to receive the selected files again. 

Helpful Hints 

 If a file has been restored to your mailbox by the SAIG/CPS Help Desk, the 
Restored Date field will be populated with the date the file was put back in 
the Archive. 

 The date listed in the Add Date column of the Received File View 
represents the date a given item was placed in your SAIG/FTI-SAIG 
mailbox by the Application System that processed that item. 

 To restore files older than ten days to your SAIG/FTI-SAIG mailbox, use 
the Transaction Delivery Community Manager (TDCM) Archive View or 
contact the SAIG/CPS Help Desk at 800-330-5947. The TDCM/FTI-TDCM 
is available online at https://saigportal.ed.gov/tdcm (SAIG) and 
https://ftisaigportal.ed.gov./tdcm (FTI-SAIG).  

The SAIG/CPS Help Desk can restore any file to your mailbox if it is not older than 90 
days. Files older than 90 days are archived and cannot be restored. 

https://saigportal.ed.gov/tdcm
https://ftisaigportal.ed.gov./tdcm
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5.3.9 Message Class Manager View 
The Message Class Manager controls the allowable message classes that can be sent 
and received.  
The Message Class Table must be imported to send or receive messages and is 
updated periodically by FSA.  The Message Class table is available on the 
https://fsapartners.ed.gov/knowledge-center/topics/software-and-other-tools/edconnect.  
Note! EDconnect will automatically import this table once you have established a 
connection with FSA. 
Sample illustration of Message Class Manager 
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5.3.10 Views 
The table below lists all the views within EDconnect that play a role in data 
transmission.  
The middle column displays the toolbar button for each view (clicking a view’s toolbar 
button opens that view). 
 

 
View 

Toolbar 
Icon 

 
Description 

Transmission 
Queue (TQ) 

 

Lists pending Send and Receive 
requests, which remain in the TQ 
until processed or until you remove 
them. 

Activity Log 
 

Lists processed requests to send 
and receive data from the 
SAIG/FTI-SAIG. 

Message Class 
Manager  

Lists all the message classes, by 
project, that are available to send 
and receive. 

Mailbox Query 
 

Lists the data, by message class, 
available in your SAIG/FTI-SAIG 
mailbox. 

Received File 

 

Lists data records, by message 
classes that have already been 
received from your SAIG/FTI-SAIG 
mailbox during the last ten days. 

Security 

 

Lists Security Groups and User 
IDs and controls access to 
EDconnect and the SAIG/FTI-
SAIG. 
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5.3.11 Import (.imp) files 
An .imp file is very large version of a .tqt file. This is the most effective way for an 
institution to send large batches of records in one transmission. Only users that are set-
up as “unattended” users can use .imp files. 
All .imp files must be created in a specific record layout in order to transmit successfully. 
Using an application such as Text pad is recommended to create the records, as they 
are dependent on the exact placement of information, and Text pad displays this 
information. 

5.3.11.1 Setting up an .imp file 
Below are the specific requirements for creating an .imp file. 

Header Record 

Field 
Number Description Type Required Length Position 

1 Serial Number Numeric No 4 1-4 

2 Return Code Numeric No 4 5-8 

3 Group ID AlphaNum No 50 9-58 

4 Unattended User ID AlphaNum No 50 59-108 

5 
Encrypted User 
Password AlphaNum 

Yes 
8 109-116 

6 
Response File 
Name AlphaNum 

No 
260 117-376 

 

Data Record 

Field 
Number Description Type Required Length Position 

1 Serial Number Numeric No 4 1-4 

2 Return Code Numeric No 4 5-8 

3 Action Alpha 

No (Except 
when Action 
is = T) 1 9 

4 Message Class AlphaNum Yes 8 10-17 

5 
Fully qualified Path 
and File Name AlphaNum 

Yes (for 
sending files 
only) 260 18-277 

6 Batch Number AlphaNum No 50 278-327 

7* Mailbox AlphaNum No 7 328-334 

* Ignored unless Servicer Mode is enabled. Contact the SAIG/CPS Help Desk to enable Servicer Mode if 
it is applicable to your institution. 
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Field Descriptions 
Serial Number—This field is for positional reference only. No editing is performed on 
this field, and it is not required. Mainframe systems should use this position to 
sequentially number the commands in the input file. 
Return Code—This field represents the success or failure of processing this command. 
This field is ignored on input records, so it can be populated or left blank. However, this 
field will be populated with the return code for this record's activity in the Response File. 
(See Response File Name below.)  
Unattended User ID—This field represents the Unattended User ID to use with the 
processing of this import file. This field is not required. If no Unattended User ID is 
specified for the current user, the user specified in the EDconnect.ini file is used. If an 
Unattended User ID is specified, that Unattended User ID must be listed in the Group 
ID that is provided. If no Group ID is specified for the current user, and the Unattended 
User ID is provided, it must be unique across all groups. Note that this is not the User 
Name field. The User Name field is used for auditing purposes by the Student Aid 
Internet Gateway. 
Group ID—This field represents the Group ID to use with the processing of this import 
file. This field is not required. If no Group ID is specified for the current user, and the 
FSA User ID is provided, it must be unique across all groups. If neither FSA User ID 
nor Group ID is specified, a password must be provided for the user importing the file.   
Encrypted Password—This field represents the password to be used with the 
specified or current user name. In EDconnect 8.6.1, the password is encrypted for extra 
security. The encrypted password can be found on the User Profile in EDconnect. If no 
FSA User ID or Group ID is specified, this password should match the user specified in 
the Edconnect.ini file. If the password does not match, the import process is aborted, 
and the appropriate return code is written to the response file. The encrypted password 
can be found by going to the Security View screen, User, Properties tab, under the 
Verify Password field.  
Passwords can contain special keyboard characters, such as @, #, and $, but because 
some computer platforms and programs use special characters as command 
characters, we recommend avoiding % (percent), ^ (caret), & (ampersand), < (less 
than), > (greater than), and | (“pipe” symbol). Do not use \ (backslash), / (forward slash), 
“ (double quotation mark), or ? (question mark). 
Response File Name—This field represents the file to which EDconnect writes the 
return codes associated with each command record. This field is not required and if not 
completed, a file called TQ.ERR in the current EDconnect directory is created. This 
response file contains an exact copy of the input file with the return code column filled in 
with the result of executing the command. This field must be a valid long file name if 
present.  
Action—This field represents the action to perform with the current record. “T” is 
currently the only valid action value. A command record with a “T” in the action column 
will immediately transmit the batch-mode added contents of the TQ and record all 
transmission activity in the Activity Log. Note that only records within the TQ that have 
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the “Batch Mode” field set to True are transmitted during an import transmission. The 
“T” record must be the last record in the import file if present at all. Only one “T” record 
should be present in a given import file. If the action column contains a “T”, all fields on 
the same record following “Action” are ignored. Leaving the action space empty will set 
the transmission to “Manual”, and after loading the batch mode contents, the user will 
transmit the batch-mode added contents using the “Transmit” feature.  
Message Class—This field represents the message class to use for this command. 
This field is used to cross-reference the message class database to populate the 
majority of the TQ records. This field is required for all data records that do not have an 
Action Type of “T”. 
File Name—This field is required for requests to Send files. It represents the name and 
the path of a file to transmit to the Student Aid Internet Gateway. However, this field 
should be blank for requests to receive files.  Only the Receive path in the Unattended 
User ID properties determines where a file is received.  If the Receive path in the 
Unattended User ID properties is blank, then the path of the Message Class, as listed in 
the Message class Manager, determines where a file is received. 
Batch Number—This field is a pass-through value that each Application System can 
utilize as it wants. There is no editing done on this field. 
Mailbox—This is a restricted use field and can only be used by Data Providers within 
the Student Aid Internet Gateway. This field will be rejected if used and the proper setup 
has not been completed. If you are a data provider and want to use EDconnect, please 
contact the SAIG/CPS Help Desk. 
This field is used to indicate to which mailbox data is to be sent on Send records. 
Validation of this field is limited to checking the length, as a complete list of all 
mailboxes within the SAIG/FTI-SAIG system is not available until a connection with the 
SAIG/FTI-SAIG is established. If this field is left blank, the import process defaults the 
mailbox value to the corresponding mailbox specified in the Message Class Manager 
table. 
Return Codes 
Below is the list of possible return codes you may receive if your .imp file is not created 
correctly. These will appear in the error log, the location and name of which is 
designated in the Response File Name field.  
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Value Description Corrective Action 

0000 Command Successful None 

9999 User Error—The supplied user 
could not be loaded 

1. Ensure that the specified user exists in the 
EDconnect Security View. 

2. Execute a disk verification program 
(Scandisk). 

9998 Transmission Error—The import 
process was unable to 
completely finish the requested 
import transmission process. 

1. See the EDconnect Help system for 
connectivity problem resolution. 

2. Review Activity Log for possible causes. 

9997 General Error—A general error 
has occurred. 

Contact CPS/SAIG Technical Support. 

9996 Duplicate—A record was 
requested to be added to the TQ 
that was already present. 

Remove the duplicate request from the import 
file or from the existing TQ. 

9995 Unknown Action—A record with 
an unknown action type was 
submitted. 

Validate that all records in the import file have 
a valid action type. 

9994 Password Error—An incorrect 
password was given for the user. 

Verify that the password being used is valid for 
the specified user. 

9993 Access Error—The user does 
not have access to perform this 
operation. 

Verify that the security group in which the user 
belongs has update rights to the TQ. 

0006 Message Class—Invalid value. Verify that the message class import record 
exists in the Message Class database. 

0007 File name—Invalid value. Ensure that the file path is correct, and that a 
corresponding file exists in the specified 
directory. 

0009 Incorrect Relationship b/t ID & 
Message Class 

Verify the relationship between the ID and 
Message Class is correct. 

0010 Batch Number—Invalid value. Ensure a correct length for the Batch Number. 

0012 Mailbox—Invalid value. 1. Ensure that a correct length mailbox is 
specified. 

2. If adding a send record, ensure that the 
mailbox is specified in either the record or 
the message class database for the 
associated message class. 

0013 Missing TG/FT Number Applies to Servicer Mode only. Verify that the 
TG/FT number is in the correct spaces of 
record layout. 

All others  Contact CPS/SAIG Technical Support. 
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Below is a partial image of a correctly set up .imp file.  

 
The ‘T’ in the bottom line indicates that this is an automatic file. By placing the ‘T’ there, 
this will bypass the Security Authentication process and transmit automatically.  
The other option is to leave that space empty. This creates a manual transmission, 
meaning that after the Security Authentication process is bypassed, the ‘Transmit’ icon 
or the ‘Now’ option in the Transmission menu must be selected by the user.  
 
5.3.12 Unattended Transfer User ID and .imp files  
For SAIG usage, the unattended transfers are normally used for sending large .imp files 
during off-peak hours to avoid slowing down the system. Only users marked as 
unattended users can use .imp files.  For the purpose of this document, these users 
will be referred to as Unattended User IDs.   
NOTE: FTI Users (FTI-SAIG) cannot perform unattended transfers. This is only 
applicable to non-FTI (SAIG) users. 
In the Security view, the user that will be making the unattended transfer must be 
marked as an unattended user, making it an Unattended User ID.  Any username can 
be created for an Unattended User ID; it does not have to be an FSA User ID.  
Unattended User IDs will not be visible in the Security Authentication screen or able to 
log into EDconnect following a transmission in order to verify success.  
An FSA User ID can be marked as an unattended user by checking the box in the User 
Properties dialog box, as shown below. Once this box is checked, the password fields 
will appear, allowing the FSA User Password to be entered and stored.  
NOTE: Since an Unattended User ID is not able to log into EDconnect, an FSA User 
ID marked as unattended will not be able to log in.  If Unattended User is marked 
accidently, a different FSA User ID will have to login in order to uncheck the 
Unattended User ID.  It is highly recommended to create a username different from 
your FSA User ID to use as an unattended user. 
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5.3.12.1 Loading .imp files into the TQ and Manually Transmitting as an Unattended 
User 

For the manual transmission, you will need your .imp file to have the last link as blank.  
Note – the last line reads 00060000. There is no ‘T’ following the number. This 
means a user will have to physically select the ‘Transmit’ icon or the ‘Now’ option 
under the Transmission menu. 

 
1. On your desktop, where your EDconnect shortcut is, right-click on the shortcut 

and select ‘Create Shortcut’. A second shortcut icon should appear. You can 
rename this as ‘.imp shortcut’. 

You will need to add a string to the Target path where the .imp file is stored-in this case, 
it is in the C:\IAM\SAIG_temp\ directory. The Target path will display where your 
Edconn852.exe file is stored. In this example, the Edconn852.exe is in the 
C:\ProgramFiles/Edconnect8 directory.  
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2. Right click on the ‘.imp shortcut’ icon and select Properties. At the end of the 
Target path, enter “C:\IAM\SAIG_temp\FISAP.imp” so that it reads “"C:\Program 
Files (x86)\EDconnect8\EDconnect8.exe" ” <path to IMP file>”. Click Apply, then 
OK.  For example, " "C:\Program Files (x86)\EDconnect8\EDconnect8.exe" 
C:\temp\test_notrans.imp  

 
3. Double-click the ‘.imp shortcut’ icon. The EDconnect logo will appear, and then 

minimize to the task bar. Click on this to view EDconnect and verify that you are 
looking at the Security View.  

4. Click on the TQ icon and verify that the files loaded.  
5. Click the ‘Transmit’ icon or the ‘Now’ option in the Transmission menu. 
6. Verify transmission is successful. You also double check this looking at the 

Activity Log.  
 
5.3.12.2 Loading .imp files into the TQ and Automatically Transmitting as an 

Unattended User 
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 For the manual transmission, you will need your .imp file to have an extra ‘T’ in 
the last line.  
Note in the example, the last line reads 00060000T. This ‘T’ is the designator for 
an automatic, unattended transmission. This also means that a user does not 
have to physically select the ‘Transmit’ icon or the ‘Now’ option under the 
Transmission menu.  

 
 On your desktop, where your EDconnect shortcut is, right-click on the shortcut 

and select ‘Create Shortcut’. A second shortcut icon should appear. You can 
rename this as ‘.imp shortcut’. 

 You will need to add a string to the Target path where the .imp file is stored-in 
this case, it is in the “C:\IAM\SAIG_temp\” directory. The Target path will display 
where your EDconnect8.exe file is stored. In this example, the EDconnect8.exe 
executable is in the C:\ProgramFiles (x86)/EDconnect8 directory. 
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1. Right click on the ‘.imp shortcut’ icon and select Properties. At the end of the 
Target path, enter “C:\IAM\SAIG_temp\FISAP.imp” so that it reads “C:\Program Files 
(x86)\EDconnect8\EDconnect8.exe” “C:\temp\test_notrans.imp”. Click Apply, and 
then OK. 

 
 

 
2. Double-click the ‘.imp shortcut’ icon. The EDconnect logo will appear, and then 
minimize to the task bar. Click on this and verify that the transmission process has 
begun. 
3. Verify transmission is successful. You can also double check this looking at the 

Activity Log.  
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6. Using the EDconnect Test Environment 
NOTE: FTI-SAIG does not have a test environment.  This section applies only to SAIG 
users.  In order for users to access the test environment, a system will need to set up a 
designated “test” security group. Once the test Security Group, or test TG mailbox, has 
been created, the Connection Type will need to be redirected from Production to 
Test.  
To redirect a Connection Type to the test environment, users will need to follow the 
steps below: 

1. Set up a new dedicated “test” security group. This test group should not be used 
in the production environment.  All testing should be conducted on the test 
environment using the designated “test” security group the user creates.  

2. Next reset the test account user password.  To connect to the test environment, 
users will need to reset their test account passwords. 

 
Note: User passwords on the production and test environments are not in sync.   
Users must contact the SAIG/CPS Help Desk to reset their test account passwords. 
If you have not used the test environment in the last 90 days, your password has 
expired and will need to be reset. 
 
3. Open the Security View by selecting New from the File menu and selecting 

Security View from the list of views. You can also click the Security View button 
(Pad Lock icon) from the main EDconnect toolbar. 

4. Right-click on the Security Group or TG Mailbox you wish to test and select 
Properties from the menu. 

5. Next, select the Network tab shown on the Group Properties screen. 
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6. Once you are on the Network Group Properties screen, change the Connection 
Type from Production to Test.  Next, select Finish. 
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7. System should receive the EDconnect warning message that reads “Your 

Network Connection Type is set as Test.  Any files you send or receive will be 
transmitted through the test system and will not be processed.” 
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7. EDconnect Error Codes 
If a transmission fails, EDconnect asks you to review the Activity Log for details. In 
most cases, the error message in the Activity Log consists of an error number followed 
by a brief explanation of the error. 
The first section of the EDconnect 8.6.1 Error Code List provides descriptions of 
Numerical Errors you may receive and their possible resolutions. Some of the 
resolutions may require the help of your technical support staff or network 
administrators. 
Under certain circumstances, you may receive non-numerical error messages or other 
program errors. These are described in the Non-numerical Errors section of the list.  
Entries are arranged alphabetically unless the most common cause of a particular error 
is noted first. 
Security Authentication Errors occur when a user tries to login to EDconnect without the 
proper credentials. You will need your assigned FSA User ID and Password, and One-
Time Password, if applicable, from FSA before you can login to EDconnect. 
The instructions assume that the EDconnect program files have been installed to the 
default C:\Program Files (x86)\EDconnect8 folder. The program files will typically be 
located on the local hard drive even if the EDconnect database is on a network drive. If 
EDconnect has been installed to a different folder, adjust the instructions accordingly.  
Before contacting the SAIG/CPS Help Desk (800-330-5947, or by e-mail at 
CPSSAIG@ed.gov) for assistance with transmission problems, make sure that you are 
able to access the Internet. EDconnect uses your existing Internet connection. If you are 
unable to view Web pages in your Web browser, EDconnect will not be able to connect 
to the Student Aid Internet Gateway (SAIG/FTI-SAIG). 
You may also want to try one or more of the following to resolve transmission problems: 
 Exit EDconnect, log back in, and try another transmission. 
 Restart your computer and try another transmission. If you connect to the 

Internet through a Local Area Network (LAN), restarting your computer may 
establish a better connection. 

 If you connect to the Internet through a modem and an Internet Service Provider 
(ISP), disconnect from the Internet and connect again. Try another transmission. 

 Wait and try another transmission later. If you have been successfully sending 
and receiving files using EDconnect, many transmission errors (Error -1 and 
Error 4xx, in particular) will resolve themselves. 
 

Note: After a failed transmission, a Mailbox Query will usually report that your “Mailbox 
is empty.” This does not mean that your files have been lost. A successful transmission 
is required before a Mailbox Query will accurately reflect the contents of your 
SAIG/FTI-SAIG mailbox.  
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Under normal circumstances, you will not lose any files due to transmission failures. 
The EDconnect Activity Log can help you determine which files you have successfully 
received. 
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7.1 Numerical Errors 
An error code may be preceded by a minus sign, as in Error -1. The presence or 
absence of a minus sign does not change the meaning of the numerical codes listed 
below. 
Note: The SAIG/CPS Help Desk cannot provide specific information for configuring 
firewalls and proxy servers, although we may be able to offer general assistance. 

7.1.1 Error -1  
Error -1 indicates that EDconnect cannot connect to the SAIG/FTI-SAIG. You will 
receive Error -1, for example, if your Internet connection is not responding or if a 
firewall is preventing EDconnect from accessing the Internet. 
Listed below are some of the possible causes of Error -1. 
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7.1.2 Error 2 

Error 2 occurs when EDconnect cannot establish an FTP session.  

Problem Solution 
Inadequate 
permissions or 
settings 
 

You may not have the necessary permissions or access rights on your 
workstation or network to transmit with EDconnect. Read, write, and 
modify rights are required to the local drive and network location of the 
EDconnect database file “Edconn8.mdb” if applicable. Check with your 
technical support staff. Have one of your network technicians log into your 
workstation as an administrator and try a transmission. If the transmission 
is successful, the technician will need to change your permissions or 
access rights. 

Internet connection is 
not working 

Make sure you are able to view Web pages in your Web browser. If you 
are unable to access the Internet, EDconnect will not be able to connect to 
the SAIG/FTI-SAIG. 

Local Area Network 
(LAN) connection is 
not plugged in 

Make sure the LAN cable is connected to your workstation. If it is not 
plugged in, plug the cable back into the network card in your workstation. 

Recreate your firewall, 
proxy server or traffic 
shaper rules 

Contact your IT department to see if a network technician can delete any 
references or rules regarding EDconnect using Port 26581 to access 
saigmailbox.ed.gov, including a defined “host" for the IP address of 
saigmailbox.ed.gov; then recreate these rules. 

Restart your computer If you access the Internet through a LAN, rebooting your computer may 
help resolve Error 1. Restarting your computer will establish a new 
connection to your network. 

Port 26581 is closed by 
a firewall 
 

Port 26581 must be open for outbound TCP/IP transmissions and enabled 
for FTP sessions, and you will need to be able to connect to 
saigmailbox.ed.gov. If you have never successfully transmitted with 
EDconnect, contact your network administrators to see if you are behind a 
firewall. 

Proxy client not 
installed 
 

Error -1 may occur if a proxy server is running on the network but there 
are no proxy clients on the workstations using EDconnect. Installing the 
proxy client on any workstation that uses EDconnect may allow 
transmissions to go through. 

Proxy server is not 
configured correctly 
 

If you have a proxy server, port 26581 must be open for outbound TCP/IP 
transmissions and enabled for FTP sessions. Your network administrators 
may need to add rules to the proxy filters. Common proxy servers include 
WinProxy, MS Proxy Server, WinGate, and BorderManager (Novell). 
Product vendors may be able to provide specific information about proxy 
setup. 

Temporary problem 
with the SAIG 
 

Occasionally, there may be a momentary disruption of the SAIG, causing 
you to receive Error -1. If you normally do not have trouble transmitting 
with EDconnect, the problem will usually resolve itself in a short time. Try 
another transmission later. You may want to wait until after peak SAIG 
network demand, which is between 8:00 a.m. and 10:00 a.m. Central 
Time. 

Workstation has no 
firewall client 
 

If your network has a firewall, the firewall may require a client on 
workstations that use EDconnect. You may receive Error -1 if the client is 
not installed. Your technical support staff should install the firewall client, if 
necessary, on workstations that use EDconnect. The firewall vendor may 
be able to provide technical assistance. 
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Problem Solution 
Error 2 occurs 
immediately upon 
transmitting 

To resolve the error, confirm all of the following subdirectories exist under 
the C:\IAM\SAIG_temp directory:  
Data, Error, Incoming, Maint, Mdn, Outgoing, Runtime (which will contain 
the subdirectory “ign”), Security  
Temp (which will always contain files)  
Should any of these directories not exist, please manually recreate them, 
or reinstall EDconnect.  
Next, check that you have read/write/modify permissions to these 
directories as they are all required.  You may need to contact your 
technical support staff for assistance. 
 
Note: This error can also occur when EDconnect cannot establish an FTP 
session. See Error -1 for possible solutions. 
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7.1.3 Error 3 
Error 3 occurs during a transmission and prevents files from being sent or received.   

Problem Solution 
Error 3 occurs during a 
transmission and 
prevents files from 
being sent or received.   

Users may not have the necessary permissions to receive or send files 
from a directory. For example: 

• User may not have read/write/modify permissions  
• User may have read-only permissions 
• User lost connection to their network drive 

If experiencing this issue, contact your technical support staff to assist. 
 
Receiving files to a directory with an apostrophe in the name.  
 
User is without read/write/modify permissions to the C:\IAM\SAIG_temp 
folder.  Contact your technical support staff to assist. 
To verify or modify the current Send or Receive directory : 

• Go to the Security View in EDconnect by selecting File > New > 
Security View. 

• Right-click the FSA User ID. 
• Click Properties. 
• Click Directories. 
• Click the down arrow next to Database and select Receive or 

Send. 
• The current directory for each will be listed in the box below.  
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7.1.4 Error 4xx 
Error 4xx (the “xx” can denote any number combination) is the result of a 
slow network connection, which may be due to problems on your network or 
unusually high network traffic. If you have been transmitting successfully with 
EDconnect, Error 4xx is usually a temporary problem that will resolve itself. 
Waiting and trying another transmission later will frequently solve the problem 
without any further action on your part. 
Listed below are some of the possible causes of Error 4xx. 

 
Table 3: Error 4xx 
Problem Solution 
General connectivity 
problems 

 

• Your network may be running slowly or dropping its 
connection to the Internet. Check with your technical support 
staff to see if there are problems with your network 
connection. 

• Unusually heavy traffic on your local network may cause 
Error 4xx. If you only experience Error 4xx at certain times 
of day, check with your network administrators to see if those 
times coincide with peak network demand. 

• Unusually heavy traffic on the SAIG may cause Error 4xx. 
Try another transmission later. Peak SAIG/FTI-SAIG usage is 
often between 8:00 a.m. and 10:00 a.m. Central Time. 

If you access the Internet through a LAN, rebooting your 
computer may help resolve Error 4xx. Restarting your 
computer will establish a new connection to your network. 

You may have too 
many programs 
running 

See if closing some programs will stop the error or increase 
transmission speed. 
 

Your network uses  
software to set 
priorities for Internet  
connections or to 
limit Internet access 
 

Programs that set priorities for Internet traffic can trigger this 
error. If the priority for EDconnect is set too low,  
EDconnect may “time out” with either Error -1 or Error 4xx. 

Any program that filters Internet packets or scans files during a 
transmission may interfere with EDconnect. Check with your 
network administrators. They may want to disable these types of 
programs temporarily to see if the programs are causing the 
problem. 

Error 422 This error results from the DHONLY value in the tdclient.ini file 
being set incorrectly in the [FTISAIGPORTAL] section.  The 
value should be set to N. You will also receive error 422 if the 
runtime certificate files are not imported into the proper location, 
or if the User ID does not match between the RTM and the 
tdclient.ini file. 

 

7.1.5 Error 5xx 
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Listed below are some of the possible causes of Error 5xx. 
 
Table 4: Error 5xx 
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Problem Solution 
Error 530 “Please see 
the EDconnect error 
codes listed in the 
EDconnect installation 
and User Guide for 
further information." 

 If you receive Error 530, you will need to confirm that the TG number you 
are using to transmit is the correct FT/TG number. You can check by 
selecting File, New, Security View from the EDconnect menu bar, right-
clicking on the group (not the user) your FSA user ID is under, choosing 
Properties, and clicking on the Network tab of the Group Properties 
dialog box. The FT/TG number field is at the top of the tab. 

 
If the TG number is correct, your FT/TG password (SAIG/FTI-SAIG 
network password) is incorrect, and you will need to call the SAIG/CPS 
Help Desk to have your password reset. In order to reset your password, 
CPS/SAIG Technical Support requires the Social Security Number and 
date of birth of the Destination Point Administrator assigned to the FT/TG 
number. 

Additionally, users may receive an Error 530 in the following scenarios: 

• Scenario 1:  
A user switches between profiles with mailboxes assigned to the 
Prod and Test environments. 
Example 1:  An EDconnect user is logged into group mailbox 
TG50000, which is assigned to the Prod environment. The user 
then logs in to group mailbox TG22222, which is assigned to the 
Test environment, via the Security View. When the user attempts 
to transmit from TG22222, EDconnect fails to transmit and 
produces Error 530. 
Example 2: A user is logged into group mailbox TG50000, which 
is assigned to the Prod environment. The user then logs in to 
group mailbox TG50000, which is assigned to the Test 
environment, via the Security View.  When the user transmits 
from TG50000 on ProdT, the transmission fails with Error 530. 

• Scenario 2: 

Changing a mailbox password outside of EDconnect (i.e., through 
TDCM or the Help Desk) requires passwords to be synchronized 
depending on how EDconnect was installed (i.e., a network install 
with a shared edconn.mdb will require each group to update the 
password).  
Example 1: Edconn.mdb file is shared by all EDconnect users on 
the same network. 
User1 from TG50001, Group A, changes password on TDCM. 
User2 from TG50001, Group A, cannot transmit 
User2 will not be able to transmit until someone from group 
A executes a local password change in EDconnect. 
Example 2: Edconn.mdb file is installed on a local machine. 
User1 from TG50001 changes the network password from their 
machine. 
User2 from TG50001 receives Error 530 when transmitting from 
their machine. 
User2 must execute a local password change in order to 
synchronize and transmit from their machine. 

• Scenario 3: 

The FT/TG number entered in your group is inactive or was 
entered incorrectly in the Group Properties dialog box (E.g., 
“50001TG” was entered instead of “TG50001”).   
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Error 531 
“Your SAIG network 
password has 
expired.” 

If you receive Error 531, you need to transmit a new SAIG/FTI-
SAIG password. This error code appears in the Activity Log or the 
More window of the Transmission screen. Following the failed 
transmission, EDconnect asks if you would like to complete a SAIG 
password change. If you select Yes, the program takes you to the 
appropriate network wizard security screen and walks you through 
the password change. You will need to perform another 
transmission in order to transmit the new password. 

See Error 536, below, for SAIG password rules. 

Please note that performing a Network and Local SAIG/FTI-SAIG 
password change does not change your user password. “Local,” in 
this context, refers to the fact that EDconnect stores the SAIG/FTI-
SAIG password locally (i.e., within the database). 

Error 535 
“You are attempting to 
reuse a previously 
used TG Password. 
Please select a new 
TG Password.” 

Your network password cannot be the same as any of the five 
network passwords you have used most  
recently. 

Error 536 
“Your FT/TG password 
does not meet the 
minimum criteria. 
Please see the 
EDconnect error 
codes listed in the 
EDconnect Installation 
and User Guide for 
further information.” 

EDconnect has specific rules for SAIG/FTI-SAIG passwords: 
• The password must have a minimum length of 15 

characters and must contain each of the following four 
types of characters  

o English uppercase letters (A-Z) 
o English lowercase letters (a-z) 
o Westernized Arabic numerals (0-9) 
o and non-alphanumeric special characters, 

specifically (!,@,#,$,&,*) 
• The password cannot contain any words that are easily 

guessed like dictionary words, names, or acronyms 
• The password must contain at least four (4) alphabetic 

characters, and 
• The password cannot contain three (3) or more identical 

characters in a row. 
Error 537- “You have 
exceeded the 
maximum number of 
attempts to log in and 
your account has been 
locked. Please call 
CPS/SAIG Technical 
Support at 800/330-
5947 to have your 
account unlocked.” 

For enhanced security, after three failed transmissions due to an 
invalid SAIG/FTI-SAIG password, your SAIG/FTI-SAIG account will 
be locked. After 15 minutes, the lock will expire, and you can try 
again. If you need to call the SAIG/CPS Help Desk to reset the 
password, the Help Desk requires the Social Security Number and 
date of birth of the Destination Point Administrator assigned to the 
FT/TG number. 
 



                                                                                       EDconnect Error Codes 

February 24 EDconnect 8.6.1 User Guide 
 114 
 

Error 540 - "Either the 
FT/TG number or 
existing FT/TG 
password you 
provided was 
incorrect.  Please 
verify accuracy of 
information and 
resubmit." 

The wrong password was entered.  Re-enter the password. 
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7.1.6 Error 10 
Table 5: Error 10 

Problem Solution 
“No networks defined” in the 
tdclient.ini file 
 

Error 10 usually indicates that EDconnect was not installed 
correctly. Back up the database  
(EDconn8.mdb) and uninstall EDconnect. Perform a full 
installation. Replace the blank EDconn8.mdb with the 
database you backed up. Please call the SAIG/CPS Help 
Desk for assistance if necessary. 

Inadequate permissions or 
settings 

 

You may not have the necessary permissions or access 
rights. Read, write, and modify permissions are required to 
the local drive, including the C:\IAM\SAIG_temp\ directory, 
and to the network location of the EDconnect database file 
“Edconn8.mdb” if applicable. Check with your technical 
support team to confirm your permissions or have a network 
technician log into your workstation as an administrator to try 
a transmission. If the transmission is successful, the 
technician will need to change your permissions or access 
rights. 

 

7.1.7 Error 13 
Table 6: Error 13 

Problem Solution 
Inadequate permissions or 
settings 
 

You may not have the necessary permissions or access 
rights on your workstation or network to transmit with 
EDconnect. Read, Write, and Modify permissions are 
required to the local drive, including the C:\IAM\SAIG_temp\ 
directory, and network location of the EDconnect database 
file “Edconn8.mdb”.  Check with your technical support staff 
or have a network technician log into your workstation as an 
administrator and try a transmission. If the transmission is 
successful, the technician will need to change your 
permissions or access rights. 

The “list.fil” file is in use by 
another program. 

During testing, SAIG encountered this error when the “list.fil” 
file was open in another program during a transmission. 
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7.1.8 Error 15 
Table 7: Error 15 

Problem Solution 
Inadequate permissions or 
settings 

 

You may not have the necessary permissions or access 
rights on your workstation or network to transmit with 
EDconnect. Read, Write, and Modify rights are required to 
the:\IAM\SAIG_temp\ directory, including to the Tdclient.ini 
file that is within this directory.  Check with your technical 
support staff. Have one of your network technicians log into 
your workstation as an administrator and try a transmission. 
If the transmission is successful, the technician will need to 
change your permissions or access rights.  
If the tdclient.ini file is missing from the C:\IAM\SAIG_temp 
directory, reinstall EDconnect. 

7.1.9 Error 34 
You will receive Error 34 if there is not sufficient free space on the drive on which 
the Send and Receive folders are located. Make sure the drive has enough free 
space. 

7.1.10 Error 70 
EDconnect may be trying to access a file or folder on a network drive that 
another user is also trying to access. Restart your computer and try the 
transmission again. 

7.1.11 Error 73 
Error 73 indicates that EDconnect cannot connect to the SAIG if your Internet 
connection is not responding or if a firewall is preventing EDconnect from 
accessing the Internet. 
Verify that the DATA_OVER_COMMAND entry in the tdclient.ini file in the 
[FTISAIGPORTAL] section is set to Y.  See Error -1 above for some additional 
possible causes. 
 

7.1.12 Error 103 
Restart your computer and try another transmission. If you continue to get Error 
103, back up your EDconnect database (EDconn8.mdb) and uninstall and 
reinstall EDconnect. Restore your original database. Please contact CPS/SAIG 
Technical Support if you need assistance. 
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7.1.13 Error 107 
Table 8: Error 107 

Problem Solution 
An FTP session cannot be 
initiated 
 

This error occurs when an FTP session cannot be 
initiated by EDconnect. See Error -1 for possible causes 
of this error. 

Some of the EDconnect 
program files or folders are  
read-only or have inadequate 
rights 
 

Files that have been saved to CD have the read-only 
attribute set by default. If you have restored any 
EDconnect files from a CD backup, make sure you 
remove the read-only attribute from all restored files. 

 
7.1.14 Error 203 
EDconnect may be attempting to access a file or a folder on a network drive that 
is in use by another user or program. Restart your computer and try another 
transmission 

7.1.15 Error 234 
See error 4.xx.  
Using a prior version of EDconnect 8 can also cause this error. 
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7.2 Non-Numerical Errors 
Table 9: Non-numerical Errors 

Problem Solution 

“Invalid sender for message class” 
error referencing CONNCT32 files 
 

EDconnect sends a CONNCT32 file each time you 
transmit. Under normal circumstances, the file is 
automatically deleted from your mailbox. If the file is 
not deleted promptly, EDconnect will try to download 
it, generating the error. You may see the error if you 
have tried several transmissions over a short period 
of time. Clicking the OK button on the error 
message dialog (this sometimes requires several 
clicks) will usually allow you to download your files. 
The next time you use EDconnect, you should not 
receive the error. 

“Invalid sender for message class” 
error referencing files other than 
CONNCT32 

Contact the SAIG/CPS Help Desk at 800-330-5947 
for assistance with this error. 

“Path does not exist” during 
Transmission 

This error refers to the Send or Receive paths that 
have been set up in EDconnect, such as 
C:\IAM\Data. 

If you receive this error, first check to make sure the 
paths are valid. This is particularly important if your 
Send and Receive paths are on a network drive.  

Your workstation may have temporarily lost its 
connection to the drive. 
 
If you find any read-only folders in the EDconnect 
Send or Receive paths and cannot remove the 
read-only attributes, contact your technical support 
staff. They may need to use the “attrib” command to 
remove the read-only property from folders that are 
“stuck” by opening a command prompt and using 
the command “attrib -r c:\folder name”. The 
command must be used on each read-only folder in 
the Send and Receive paths. 

“System error: unable to add/remove 
headers and trailers” 
 
 

You may receive this error if you do not have 
permission to download files to the Receive folder 
specified in EDconnect, or if you do not have 
permission to send files from the Send folder. Have 
one of your technical support staff log on as an 
administrator and try a transmission. If this works, 
your technical support staff will have to change your 
permission levels. 
 
A missing carriage return, or non-ascii character in 
the file you are trying to send can cause this error. 
Your technical support staff may need to examine 
the file or files you are trying to transmit to the 
SAIG/FTI-SAIG. 

“CALog DOC” errors during a 
 transmission, including: 

Solution options: 
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"CALogDoc::add()-it appears this 
 record has already been sent, add 
 unnecessary" 

  
"CALogDoc::add request record not  
found/add send record not found.  
Transmission partially successful " 
 
“CALog DOC: :add ()- activity 
element 
 invalid, field compressed filename.” 
 
“CALog DOC: :add ()- activity 
element  
invalid field file name” 
 

Run Compact and Repair: 
 1.  In EDconnect, go to Window, Close All. 
 2.  Go to Tools, Compact and Repair. 
 3.  Say “Yes” to the warning message. 
Run this several times if necessary.  
 
Reduce the number of records in the Activity Log: 
1. Open the Activity Log and select the following: 
Edit > Properties > Receive File tab > Enable 
automatic delete.   
2. Next, set to 365 days 
If you would like to back up the Activity Log before 
changing the activity retention period you can go to 
so by selecting “File/Save As” and saving the 
“Activity.Arc” file to a location of your choice. 

 
If you do not have the appropriate permissions to 
the location you are sending a file from, contact your 
technical support staff. 
 
If you do not have the appropriate permissions to 
the location you are sending a file from, contact your 
technical support staff. 

“CTQDoc::Add() - Invalid element 
contents”  
Followed by  
“System error: 
CMailDoc::MoveToTQ() - Unable to 
move item number XXXX to TQ” 

If you do not have the appropriate permissions to 
the location you are receiving files, please contact 
your technical support staff. 
 
You do not have the appropriate permissions to the 
C:\IAM\SAIG_temp directory or the Edconn8.mdb; if 
it resides on a network drive. 

"CTQ doc:: Add message class not 
found: system error c:mail doc 
moved to tq; memory error has 
occurred" 
 

This error may be due to database corruption. Try 
running “Compact and Repair” several times, exit 
EDconnect, log back in, and try again. 
 
Run Compact and Repair: 
  1.  In EDconnect, go to Window, Close All. 
  2.  Go to Tools, Compact and Repair. 
  3.  Say “Yes” to the warning message. 
 
Reduce the number of records in the Activity Log: 
1. Open the Activity Log and select the following: 
Edit > Properties > Receive File tab > Enable 
automatic delete.   
2. Next, set to 365 days 
3. Log out of EDconnect, log back in, and try 
transmitting again. 
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You do not have appropriate permissions to the 
C:\IAM\SAIG_temp directory or to the Edconn8.mdb 
if it resides on a network drive.  Please contact your 
technical support staff.  

A Data File dialog appears after 
selecting Transmit Now, preventing 
files from being sent or received. 

 

You do not have appropriate permissions to the 
Send or Receive folder, depending on the activity in 
the Transmission Queue.  Contact your technical 
support staff to confirm your permissions. 

A database error has occurred. 
 
Description: Syntax error…" 
Thursday, January 23, 2023 
2:18 PM 
A database error has occurred. 
Description: Syntax error (missing 
Operator) in query expression 
'TRANSMIT = True and Activity = 
'Send AND MSG = 'CRDLMYNIN AND 
ADDDATE = '20230116' AND 
ADDTIME = '162627' AND FILENAME  
= 'S:\iam\data\crdl14in.011614 sub 
reallocation [name] ORDER BY 
ADDDATE, ADDTIME, PROJECT,  
CYCLE, MSG'. IN DAO.QueryDef 

This error may be due to database corruption. Try 
running “Compact and Repair” several times, exit 
EDconnect, log back in, and try again. 
 
Run Compact and Repair: 
  1.  In EDconnect, go to Window, Close All. 
  2.  Go to Tools, Compact and Repair. 
  3.  Say “Yes” to the warning message. 
  4.  Repeat several times if necessary. 
 
The error can also occur if a user does not have the 
appropriate rights to the folder from which the file 
being sent is located.  

“A database error has occurred.  
Description: Unrecognized database 
format" 

This error occurs upon launching EDconnect. 
 
The database is corrupt and not recognized by 
EDconnect.  Try rebooting and log in again. If the 
error persists, please contact the SAIG/CPS Help 
Desk. 

DAO” errors: 
 
“Not a valid bookmark in 
 dao.database” 
“Disk or network error in 
 dao.recordset” 
“No current record in dao record 
 space” 
“Record is deleted in dao.database.” 

The user does not have the appropriate permissions 
to the C:\IAM\SAIG_temp directory or the 
Edconn8.mdb on a network drive. Another possible 
reason for the error is that the database is corrupt. 
  
Run Compact and Repair 
  1.  In EDconnect, go to Window, Close All. 
  2.  Go to Tools, Compact and Repair. 
  3.  Say “Yes” to the warning message. 
  4.  Repeat several times if necessary. 
 



                                                                                       EDconnect Error Codes 

February 24 EDconnect 8.6.1 User Guide 
 121 
 

 
“Disk or network error in dao db 
engine” 
Preceded by “A database error has 
occurred” 
 
"A database error has occurred. 
Description: Could not find file 
'C:\IAM\DATABASE\EDconn8.mdb' in  
DAO.Workspace" 
 

The error means EDconnect is unable to locate the 
database in the expected location.  
Check the location of the database referenced in the 
error message. Is the database there? 
Possible causes of no database: 
• Performed “Local – Custom” install on a 

machine that did not already have EDconnect 
installed to it. Try re-installing EDconnect as 
“Local”. 

• Performed “Local - Custom install” when you 
meant to perform a “Workstation” install 
(existing network database). Try re-installing 
EDconnect as “Workstation”. 

• Network drive where database is located is 
unavailable. Try rebooting machine and logging 
back into EDconnect. 
  

Other causes: 
• The database is so corrupted that EDconnect 

does not recognize it. Try to restore the 
backup database or try reinstalling EDconnect 
completely. 

Permissions to the folder containing the database 
could be triggering the error.  Contact your technical 
support staff to check if you have the appropriate 
permissions. 

EDconnect installer unable to see 
network drives. 
 

If the network drive is invisible to Ede or EDconnect, 
re-enter the path in the “Universal Naming 
Convention”. 
This means that instead of entering: “drive 
letter:\path,” you would enter: 
\\servername\sharename\path 

• Have one of your network technicians 
remap the network drive.  

• Have one of your network technicians turn 
on Network Discovery. 

Have one of your network technicians disable User 
Account Control (UAC). 

"An error has occurred. Please 
contact FTI-SAIG customer service." 
This error occurs upon logging in.  
 

1. Go to My computer and open the 
c:\IAM\SAIG_temp directory.   
2. Open the edconn.err file in Notepad or WordPad.   
3. Go to the bottom of the file to verify that the last 
“System Date” and “System Time” match the time 
you received the error. 
4. The “Return Code” will be “Unknown.”   
5. Locate the Return Description and consult the 
table below. 
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 Return Descriptions mentioning 
“timestamp,” including: 

 
Return description: WSE065: 
Creation time of the timestamp is in 
the future. 
 
Return Description: WSE066:  
Timestamp is expired. 

Correct your computer’s clock so that it matches the 
current US time, to the exact minute. 
  
Return description: WSE065: Creation time of the 
timestamp is in the future 
This typically indicates lack of synchronization 
between sender and receiver clocks. Make sure the 
clocks are synchronized or use the time tolerance in 
second’s element in the microsoft.web.services3 
configuration section to adjust tolerance for lack of 
clock synchronization. 

 
Return Description: WSE066: Timestamp is expired.  
This indicates a stale message but may also be 
caused by lack of synchronization between sender 
and receiver clocks. Make sure the clocks are 
synchronized or use the time tolerance in second’s 
element in the microsoft.web.services3 configuration 
section to adjust tolerance for lack of clock 
synchronization.  

Return description: Unable to 
connect to the remote server. 
 
Return description: The operation 
has timed out. 
  
Return description: The request was 
aborted: The request was canceled. 
  
Return description: The remote 
name could not be resolved. 

 

These errors are typically caused when EDconnect 
is unable to connect to “fsaesb.ed.gov” when 
logging into EDconnect.  The issue may require the 
assistance of your technical support staff. 
  
This URL will always time out in a browser, or when 
it is pinged.  But when you enter your FSA User 
ID/Password to authenticate in EDconnect the 
software will connect to the fsaesb.ed.gov web 
address. 
 
Solutions:   
1. Install EDconnect in a supported environment. 
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Return description: The remote 
server returned an error: (407) Proxy 
Authentication Required.  

 
Return description: The underlying 
connection was closed: Could not 
establish trust relationship for the 
SSL/TLS secure channel. 
 

a. EDconnect should be installed on a 
Windows 10 or Windows Server 2012 
(32 bit or 64 bit) operating systems.  
While the EDconnect database file 
“Edconn8.mdb” can reside on a 
Windows server or PC, the EDconnect 
program files should only reside on a 
PC. 

b. Using a virtual PC or installing the 
EDconnect software directly on a server 
can cause this error.  

c. Accessing EDconnect remotely by 
using a terminal server or by other 
means can cause this issue.  However, 
if the machine where EDconnect 
resides is a PC with Windows 10, we 
can help you resolve this error on that 
PC.   

2. Reinstall EDconnect.  
a. If the database file “Edconn8.mdb” 

resides on a server, perform a 
“Workstation” install.  

b. If the database file resides on the local 
PC, create a backup copy of the 
database, and perform a “Local” install 
(without the “Custom” option) and 
restore the database. 

3. Uninstall all Windows updates that have been 
applied to the PC since this error occurred. 

4. Firewall 
a. Add fsaesb.ed.gov, or its IP address, to 

your firewall’s exceptions list. 
5. A Proxy server could be blocking the connection 

to fsaesb.ed.gov   
a. In Internet Explorer go to Tools > 

Internet Options > Connections > Lan 
Settings.   

b. Check the “Bypass Proxy server for 
local address” option and try logging 
into EDconnect 

c. Adding  the fsaesb.ed.gov URL to a 
whitelist can also fix this issue  

Packet-shaping software – If you use packet-
shaping or web-filtering software a rule may have to 
be created allowing fsaesb.ed.gov traffic. 
6. ISP - Do you connect to the internet with an 

Internet Service Provider? 
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a.  Their firewall/proxy server/packet-
shaping software may be causing this 
issue. 

7. Permissions - Lacking read/write/modify 
permissions to the hard drive, or to the network 
location of the EDconnect database file, could 
cause this issue. 

8. Try using another Internet connection, if 
available. 

9. If you have access to another PC, install the 
EDconnect application and see if it resolves the 
issue.  

Try installing EDconnect to a PC outside of your 
institution’s environment. 
 

Intermittent occurrences of the 
errors listed above 
 
 

If the error occurs intermittently, these are possible 
solutions (in addition to those listed above):  
1. Update the host’s file. 

a. Add: 165.224.204.20 fsaesb.ed.gov 
b. The location of the file should be: 

C:\Windows\System32\drivers\etc\hosts 
if you are on Windows 10. 

Clear the cache of your local server. 
“A file error has occurred. 
Description:  The file could not be 
accessed.” 
 

You do not have appropriate permissions to the 
C:\IAM\SAIG_temp directory.  Check with your 
technical support staff. 
 

1. The C:\IAM\SAIG_temp directory is missing 
one or more subdirectories.  These 
directories are: “Data,” “error,” “incoming,” 
“maint,” “mdn,” “outgoing,” “runtime” 
(including its subdirectory “ign”), “security,” 
and “temp.” If one or more these directories 
do not exist, manually create them, or re-
install EDconnect.  If you reinstall the 
software, back up your Edconn8.mdb 
database first. After the installation is 
complete, restore the database. 
 

 You do not have appropriate permissions to the 
Edconn8.mdb that resides on a network drive.  

"A file error has occurred. 
Description:  Unknown file exception  
error” 
 
 

This error occurs during a transmission. 
 
Run Compact and Repair 
  1.  In EDconnect, go to Window, Close All. 
  2.  Go to Tools, Compact and Repair. 
  3.  Say “Yes” to the warning message. 
  4.  Repeat several times if necessary. 
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Check with your technical support staff to see if 
EDconnect is on a supported system. EDconnect 
must be installed on a PC with Windows 10. If the 
database is on a server, the server must be 
Windows 2012 or 2019.   

a. Using a virtual PC or installing the 
EDconnect software directly on a server 
machine is not supported.   

b. Accessing EDconnect remotely (e.g., 
using a terminal server or some other 
remote setup) is not supported.  The 
only exception to this is if the machine 
being accessed remotely is a PC with a 
supported operating system.  

This error can also occur if a file being sent is empty 
or malformed. 

"The installed version of the  
application cannot be determined" 
error when trying to install 
EDconnect  
 

This is a permissions issue.  Right-click the installer 
file and choose "Run as Administrator." If a box 
pops up requiring a password to continue, check 
with your technical support staff. 
  
If this does not resolve the error, check with your 
technical support staff. 

“Mfc application has encountered a 
problem and needs to close” 
 

Run Compact and Repair: 
 1.  In EDconnect, go to “Window” and select “Close 
All”. 
 2.  Go to Tools, Compact and Repair. 
 3.  Say “Yes” to the warning message. 
 4.  Repeat several times if necessary. 
 
You do not have appropriate permissions to the 
C:\IAM\SAIG_temp directory, or to the 
Edconn8.mdb that resides on a network drive.  
Check with your technical support staff 

There is little or no space on the local drive or on the 
network drive; if the EDconnect database is installed 
on a network and/or files are received to the 
network. 

Remove the temporary files on the PC. 
 
Run spyware removal. 
 
If this error occurs during a transmission on a 
weekly or semi-weekly basis, upgrade to EDconnect 
8.6.1.   
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If it still occurs, close all programs when running a 
transmission.  

"Not a valid path. Must end in 
backslashes" 
Error occurs when trying to start 
EDconnect after installation. 
 
 

Reinstallation is the only resolution for this error, 
whether the database is local or on the network. For 
a local database, back up the database, perform a 
“Local” installation (full, with database), then insert 
the backed-up database into the 
C:\IAM\DATABASE, overwriting the existing blank 
database just installed.  
 
For a network database, perform a “Workstation” 
installation. You do not have to uninstall EDconnect 
first when performing this install.  
 
During a “Local” (full) install or a “Workstation” 
installation, the location of the EDconnect database 
is written to the Windows Registry. During a “Local 
Install – Custom”, it is not. It is necessary for the 
Registry to contain the database path (this does not 
apply to Network/Workstation installations). 
 
Local 
If you have an existing EDconnect database you 
would like to use and are installing EDconnect for 
the first time, putting the existing database into the 
C:\IAM\DATABASE folder and running a ”Local 
Install – Custom” will not work and will trigger the 
"must end in backslashes" error. The only way to 
use the backed-up database is to perform a “Local” 
install, which installs a new database, then put the 
backed-up database into the C:\IAM\DATABASE 
folder to overwrite the blank database installed 
during the Local install. 
 
Workstation 
Install as usual, making sure to select the correct 
database location. 

“Password Not Changed In 
Tdclient.ini” 
 

Uninstall and reinstall EDconnect, backing up the 
Edconn8.mdb database and restoring it afterwards. 
Or: 
You do not have appropriate permissions to the 
C:\IAM\SAIG_temp directory or to the Edconn8.mdb 
that resides on a network drive. Check with your 
technical support staff. 
The same folder is utilized for FTI-SAIG.  

“Search key was not found in any 
record”  
 

Run Compact and Repair: 
 1.  In EDconnect, go to Window, Close All. 
 2.  Go to Tools, Compact and Repair. 
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 3.  Say “Yes” to the warning message. 
 4.  Repeat several times if necessary. 

Unable to select Send or Receive in 
the Transmission Queue—no drop-
down arrows under Activity. 
 

This error can be associated to Windows rights to 
the network folder containing the database or to 
C:\IAM\SAIG_temp, it can also be due to problems 
with the message class table. Contact your technical 
support staff to check your permissions, Compact 
and Repair the database (Tools, Compact and 
Repair), then import (or reimport) the latest 
message class table. 
 
To reimport the latest message class table, users 
will need to check the "Override auto import of 
MESSAGTB files" checkbox (File, Import, 
Message Class File). 
 

 
 
After reimporting, return to File, Import, Message 
Class File and uncheck the "Override auto import of 
MESSAGTB files" checkbox. 
 
If these steps fail to resolve the issue, 
check with your technical support staff 
for assistance with Windows permissions. 

"Server busy. This action cannot be 
completed because the other 
program is busy. Choose “Switch to” 
to activate the busy program and 
correct the problem."  
 

This issue can have a variety of causes specific to 
the workstation or network server. It is not an 
EDconnect error. 
 
Have your technical support staff unselect the 
following security checkbox: “Turn on real time 
protection” in “Microsoft Security Essentials” to see 
if it removes the error. 
  
If you use Novell as your server software, contact 
Novell customer service.  The issue may be 
associated to a Novell setting. 
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This error can also be caused by virus/spyware 
infections. The computer should be thoroughly 
checked. 
 
Anti-virus software can also cause this error.  Users 
may need to adjust a setting so EDconnect does not 
receive this error. 

"System error: 
CMailDoc::MoveToTQ() Unable to 
move item number _____ to 
TQ" during Transmission 
 

Receiving or sending files from a directory without 
having user read/write/modify rights; or that is read-
only; or that resides on a network drive where a 
connection has been lost, can all cause this error. 
 
Lacking read/write/modify permissions to the 
C:\IAM\SAIG_temp folder?  Contact your technical 
support staff to check your permissions. 

You do not have access to this  
function" when trying to transmit 

You are logged into the FSA Administration Group, 
which cannot transmit.  On the EDconnect 
authentication log in page, select the Group ID that 
was set up to make transmissions. 

"You do not have permission to use 
EDconnect" 

You have not been enrolled for EDconnect 
entitlement or were enrolled for the entitlement with 
the incorrect personal identification information. 
Please contact your school administrator.   

 
 
NOTE: Repairing an EDconnect database from outside of EDconnect 
 
If an error prevents you from logging in to EDconnect, you will only be able to Compact and 
Repair the database file “Econn8.mdb” from outside of EDconnect. To do this, you must open the 
database in Microsoft Access. You may require the assistance of your technical support staff. 
  
Go to the directory containing the database and double-click the file. The following instructions 
are for Office 365.
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Access 365 

 
1. Create a backup of the database. 
2. Double click the production EDconnect database, or the backup (repairing the production 

database prevents having to copy and paste the repaired version). 
Note: You may have to click OK to the missing references messages multiple times. 

3. Once the database is open, select Database Tools. 
4. Select Compact and Repair Database.   

Note: You may have to click OK to missing references messages multiple times. 
5. When finished, the list of “tbl_*” files will appear on the left, as it did when you first 

opened the database.  The cursor will change from an hourglass (or the circular 
equivalent) to its default appearance. 
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8. Security Authentication Errors 
An error message will display when the security authentication process fails, and 
you are denied access to EDconnect.  
Table 9: Security Authentication Errors 

Problem Solution 
“Your password is about to expire. Choose 
Yes to go to the web page to change it.” 

Click “yes” to be routed to the change 
password website. 

“Your password is expired.  Choose Yes to go 
to the web page to change it, then return to 
authenticate.” 

Click “yes” to be routed to the change 
password website.  
Return to Security Authentication screen to 
authenticate. 

“Authentication failed. You have used an 
invalid User ID or password.” 

If you receive this error, you need to confirm 
the FSA User ID and FSA User ID password 
you are using are correct. 
 
If you are using the correct the FSA User ID, 
click Forgot Password. If you are unable to 
answer your challenge questions, you will 
need to call the SAIG/CPS Help Desk to have 
your password reset. In order to reset your 
password, the SAIG/CPS Help Desk requires 
your Social Security Number and date of 
birth. 

"Authentication failed.  This account has been 
temporarily locked for 15 minutes due to too 
many failed login attempts.  Please wait 15 
minutes and try again. 
If you have forgotten your password, please 
select the Forgot Password button to reset 
your password.  You may log in with the new 
password after the initial 15-minute wait has 
elapsed." 

If you receive this error, you will need to wait  
minutes to login again. 
 
 

“Authentication failed.  You have an account 
that has been disabled.  Please contact the 
SAIG/FTI-SAIG Help Desk for Assistance.” 

If you receive this error, you will need to call 
the SAIG/FTI-SAIG Help Desk. 

“Authentication failed. You have used an 
invalid Security Code.  If you have forgotten 
your token, choose Yes to go to the FORGOT 
Token web page.” “Otherwise, please contact 
the SAIG/FTI-SAIG Help Desk for assistance.” 

If you receive this error, you will need to call 
the SAIG/FTI-SAIG Help Desk. 

“Authentication failed. Your token information 
was not found. Please register your token. 
Choose Yes to go to the web page to register 
it, then return to authenticate.” 

Select “yes” and your browser will route to the 
register your token website. 
 
After you register your token, you will need to 
return to the Security Authentication screen to 
authenticate your credentials.  

“Authentication failed. Operation not allowed 
in current state of credential.  Please contact 
the SAIG/FTI-SAIG Help Desk for assistance. 
“  

If you receive this error, you will need to call 
the SAIG/CPS Help Desk. 
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“Authentication failed.  You have an account 
that has been disabled.  Please contact the 
SAIG/CPS Help Desk for Assistance.” 

If you receive this error, you will need to call 
the SAIG/CPS Help Desk. 

“Authentication failed. You have used an 
invalid Security Code.  If you have forgotten 
your token, choose Yes to go to the FORGOT 
Token web page.” “Otherwise, please contact 
the SAIG/CPS Help Desk for assistance.” 

If you receive this error, you will need to call 
the SAIG/CPS Help Desk. 

“Authentication failed. Your token information 
was not found. Please register your token. 
Choose Yes to go to the web page to register 
it, then return to authenticate.” 

Select “yes” and your browser will route to the 
register your token website. 
 
After you register your token, you will need to 
return to the Security Authentication screen to 
authenticate your credentials.  

“Authentication failed. Operation not allowed 
in current state of credential.  Please contact 
the SAIG/CPS Help Desk for assistance. “  

If you receive this error, you will need to call 
the SAIG/CPS Help Desk. 

“You do not have permission to use 
EDconnect.  Please contact Participation 
Management for details about how to 
participate. Choose Yes to go to the PM 
Enrollment web page.” 

Select “yes” and your browser will route to the 
PM enrollment website.  

“Error Communicating with Authentication 
Service. Please wait a while and try again or 
contact the SAIG/CPS Help Desk for 
assistance.” 

Please wait a couple minutes and try again or 
contact the SAIG/CPS Help Desk for 
assistance. 
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9. Miscellaneous  
9.1 Sorting Records 
The ‘sort’ function enables you to organize records within a particular view.  
To sort records in a view 

1. Select Sort from the Tools menu. 
2. Click the down arrow to the right of the text box to display a list of all the fields 

upon which you can perform a sort within a particular view. 
3. Highlight the Sort preference. 
4. Click OK.  

Helpful Hints 

 You can also sort records based on a particular field by double-clicking the 
column header for that field.  

 The records in that field sort in ascending order after the first double-click.  
Double-click again on the same column header to reverse the order. 

9.1.1 Filtering Records 
Using the Filter option, you can filter out records of a particular type in a view so that 
you only see certain records.  
You can filter records in the Activity Log, Message Class Manager, Received File 
View, Mailbox Query, and Transmission Queue. 
To filter records 

1. Select Filter from the Tools menu. 
2. Click on the field you want to use as the filter criteria.  
3. Enter the field contents you want to use to filter the records. 
4. Click OK.  

Helpful Hints 

 You can filter on several criteria at once. 
 To get the entire view back, open the Filter dialog box and click OK without 

entering information in any of the fields. 
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9.1.2 Changing File Paths 
Follow these steps to change the file paths for data you send and receive: 

1. Open the Security View by selecting New from the File menu and selecting 
Security View from the list of views. You can also click the Security View button 
on EDconnect’s main toolbar. 

2. Right-click on your FSA User ID in the Security View and select Properties 
from the pop-up menu or highlight your FSA User ID and select Properties from 
the Edit menu.  

3. Select the Directories tab of the User Properties dialog. 
4. Click the down arrow on the right side of the selection box (the field at the top of 

the Directories tab). 
5. Select Send or Receive from the list, depending on which directory you want to 

change. 
6. Enter the path and folder in the next field. If you do not know the path, click 

Browse to select the path and folder.  
7. If you would like all users within a Security Group to use the same file paths, 

place a checkmark in the box labeled “Set all users of this group to the specified 
directories.” Create all users in the group first. 

8. Click OK to save the directory settings. 
9. Log out of EDconnect and log back in before performing your next transmission. 

Helpful Hints 

 There are three ways to set file paths: 
 On the Directories tab of the User Properties dialog. 
 In the Message Class Manager. 
 In the Transmission Queue. 

 If you accept the default values during installation, EDconnect sets the default 
path for all files to “C:\IAM\DATA” but leaves the file path blank on the 
Directories tab of the User Properties dialog. If this field is blank, paths entered 
into the Transmission Queue or Message Class Manager take precedence 
over the default “C:\IAM\DATA” path. 

 During a transmission, EDconnect checks the TQ to see if you have specified 
paths for particular files. If you have not specified paths, EDconnect defaults to 
the paths defined in the Message Class Manager. If the Message Class 
Manager does not contain path information, EDconnect uses the default path 
established on the Directories tab of the User Properties dialog if it exists. 

 If, on the other hand, you specify a default path during setup, such as 
“D:\IAM\DATA,” EDconnect will ignore changes made to file paths in the 
Message Class Manager. Only changes made in the TQ will override the default 
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path (“D:\IAM\DATA,” in this example) established on the Directories tab of the 
User Properties dialog.  

 Before you can assign the path to a folder through the Security View, the folder 
must exist. Otherwise, you will get a “Directory does not exist” error message.
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9.2 Getting Help 
For assistance with EDconnect, contact the SAIG/CPS Help Desk. 
 
 Telephone: 800-330-5947 (no cost per call) 
 TDD/TTY: 800-511-5806 
 E-mail: CPSSAIG@ed.gov 
 Fax: 319-358-4260 
 Working hours are 8am–8pm (ET) Monday through Friday  
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10. Frequently Asked Questions 
10.1 How do I import files? 
Follow these steps to import files into EDconnect: 

1. Select Import from the File menu. 
2. On the Import dialog, choose the File Type of the file you will be importing. This 

can be either a Message Class File or a Transmission Queue File or a 
Security Setup. 

 
3. Click the Browse button to select a file to import. 
4. Click OK. 

Helpful Hints 

 The Import function can be especially useful if you have several PCs using 
the same FT/TG number.  

 Once you have downloaded the message class file on one PC, you can 
copy the file to a diskette and import it into the Message Class Manager 
on the other PCs using the Import dialog. 

 The Transmission Queue File option is for. imps and can only be used 
with a .imp file that is set up for an Unattended User ID.  
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10.2 What files do I need to move when changing PCs? 
After installing EDconnect on a new computer, be sure to copy the EDconn8.mdb file 
from the EDconnect folder on your old PC to the folder of the same name on your new 
PC.  
If you are uncertain about the location of EDconn8.mdb, EDconnect displays the path 
to the database at the bottom right of the EDconnect screen.  

 
You should also move any folders that contain files you have sent or received, 
maintaining the same file paths, if possible. On a stand-alone PC, this is often 
C:\IAM\DATA. 
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10.3 Why am I getting an “Invalid Value” error message? 
In most cases, the “Invalid Value” error message occurs because a field is empty or 
incomplete. EDconnect 8.6.0 highlights this field so you can fill it in correctly.  
 

10.4 How do I combine files? 
The Combine feature permits you to combine all files of the same message class into 
one file, if more than one is downloaded during a given transmission. 
To combine files, go to File, New, Message Class Manager View. Within the Message 
Class Manager, place a check in the box located under the Combine column for each 
message class you wish to combine. 
Warning! In order to maintain batch integrity, if you try to combine message classes that 
should not typically be combined, you will receive a warning message. The Combine 
feature should not be used, in particular, to combine files sent to you by the Common 
Origination and Disbursement (COD) System. COD files cannot be imported into the 
EDExpress or any third-party software if the individual COD files are combined. 
 

10.5 Why am I getting an error notification that cannot send a 
file? 

Prior to transmitting a batch to the SAIG, EDconnect checks the first 8 bytes of the file 
for the text “O*N05.” 
If EDconnect detects an O*N05 header in the first 8 bytes of the first record of a file, you 
will receive a pop-up error message that EDconnect has detected the presence of a 
transmission header record, and the transmission will not proceed. 
You must remove transmission headers and trailers from any files you attempt to send 
to SAIG.   
NOTE: This error notification only applies to SAIG users, since FTI-SAIG users can only 
receive data but cannot send it. 
 

10.6 What is the difference between a Security Authentication 
error and a Numerical Error? 

A Security Authentication error exclusively occurs when a user tries to access 
EDconnect without the proper credentials. When these messages appear, always 
double check your credentials to make sure they are correct.  
A Numerical or Non-Numerical Error occurs when there is an error not related to the 
Security Authentication process. These can include Internet connection problems and 
SAIG/FTI-SAIG password problems. 
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10.7 What should I do if I get Error -1? 
If your internet connection is working contact your IT department and have them check 
to see if you are behind a firewall, proxy server, traffic shaper, or content-control 
software. In order for SAIG users to connect to saigmailbox.ed.gov, port 26581 must be 
open for outbound TCP/IP transmissions.  For FTI-SAIG users to connect to 
ftisaigmailbox.ed.gov port 26586 must be open for outbound TCP/IP transmissions. 
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11. Appendix A – SAIG and FTI-SAIG User Statements 
11.1 SAIG User Statement 
Anyone who accesses Title IV program data and uses resources that access SAIG 
(such as computers or workstations) must read and sign this statement. Keep a copy of 
the signed statement for your records. A signed original SAIG User Statement must be 
completed and maintained by the destination point administrator for each of the 
destination points (electronic mailboxes) to which you have access.  
 
A SAIG User understands that if he or she intentionally submits false or misleading 
information to the U.S. Department of Education, he or she will be subject to a fine up to 
$10,000, imprisonment for up to five years, or both, under provisions of the United 
States Criminal Code (including 18 U.S.C. 1001). The SAIG User also agrees to comply 
with all provisions of Section 483 of the Higher Education Act of 1965, as amended.  
 
A SAIG User understands that the information provided to him or her by the U.S. 
Department of Education is protected by the Privacy Act of 1974, as amended. 
Protecting this information, once it is entrusted to the SAIG User, becomes his or her 
responsibility. Therefore, the SAIG User agrees to protect the privacy of all information 
that has been provided to him or her by the U.S. Department of Education. The SAIG 
user understands that any person, including himself or herself, who knowingly and 
willfully requests or obtains any record concerning an individual from an agency under 
false pretenses shall be guilty of a misdemeanor and may be fined not more than 
$5,000.  
 
Appropriate Use  
At a minimum, appropriate use consists of the following:  

• Using SAIG computing resources only for official government business. Any 
other use must be approved expressly by the U.S. Department of Education.  

• Knowing the SAIG destination point administrator for each of the destination 
points you access and how to contact them.  

• Protecting all SAIG information from access by or disclosure to unauthorized 
personnel.  

• Reporting immediately to your destination point administrator any security 
incidents, potential threats, or vulnerabilities that involve SAIG resources.  

• Protecting any tools, such as passwords, that allow you access to SAIG (these 
tools are called “authenticators”).  

• Reporting to your destination point administrator any compromise, suspected 
compromise, or incidents of sharing of a password or any other authenticator.  
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• Accessing only systems, networks, data, control information, and software for 
which you are authorized.  

• Ensuring that all information that comes from SAIG is marked according to its 
sensitivity and is properly controlled and stored.  

• Informing your destination point administrator when you no longer need access 
to a SAIG resource, such as when you change jobs or leave employment.  

• Avoiding the introduction of any code that might be harmful to SAIG.  
 
TG#__________ Destination Point Administrator (DPA)Name__________________________ 
SAIG User Name ________________________________________________________________ 
(Print) SAIG Job Title________________________SSN____________Phone #(____)_________ 
SAIG User Signature____________________________________Date_____________________ 
DPA Signature 
_____________________________________Date________________________________  

NOTE: This statement, with an original signature, must be maintained by the Destination Point 
Administrator. DO NOT SEND THIS TO SAIG 
 
11.2 FTI-SAIG User Statement 
Any individual who is not a Destination Point Administrator and who accesses Federal 
Student Aid systems or other Federal agencies’ systems for the purposes of 
administering the HEA programs, and/or uses resources that access Federal Student 
Aid systems or other Federal agencies’ systems for the purposes of administering the 
HEA programs, whether by batch or online, must read and sign this statement.  
 
The original Federal Student Aid User of Electronic Services Statement must be 
maintained by the organization. The user should keep a copy of the signed statement 
for his or her records.  
 
The user understands that intentional submission of false or misleading information to 
the U.S. Department of Education is subject to a fine up to $10,000, imprisonment for 
up to five years, or both, under provisions of the United States Criminal Code (including 
18 U.S.C. 1001). The user also agrees to comply with all provisions of Section 483 of 
the Higher Education Act of 1965, as amended.  
 
The user understands the intentional use of an access device (18 U.S.C. 1029(e)(1)) 
issued to another person or obtained by fraud or false statement to access the U.S. 
Department of Education information technology systems for fraud, commercial 
advantage, or private financial gain shall be guilty of a felony and is subject to a fine of 
up to $20,000, imprisonment for up to five years, or both, under provisions of the United 
States Code (20 U.S.C. 1097(e)).  
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The user understands that the information provided by the U.S. Department of 
Education is protected by the Privacy Act of 1974, as amended. 
 
Protecting this information, once it is entrusted to the user, becomes his or her 
responsibility. Therefore, the user agrees to protect the privacy of all information 
provided to him or her by the U.S. Department of Education.  
 
The user understands that any person, including himself or herself, who knowingly and 
willfully requests or obtains any record concerning an individual from an organization 
under false pretenses, shall be guilty of a misdemeanor and is subject to a fine of up to 
$5,000 (5 U.S.C. 552a(i)(3)).  
 
Responsibilities of the Electronic Services User  

• Appropriate uses of Federal Student Aid systems or other Federal agencies’ 
systems for the purposes of administering the HEA programs, by an Electronic 
Services User: Must use Electronic Services computing resources only for official 
government business.  

• Must use Electronic Services computing resources only for official government 
business.  

• Must ensure that a substantially Established Relationship with the applicant is in 
place (e.g., the applicant has applied for admission to the institution, the 
applicant has included the institution on the FAFSA®, or the lender holds a loan 
for the borrower) before accessing Federal Student Aid systems or other Federal 
agencies’ systems for the purposes of administering the HEA programs, to obtain 
privacy protected information about the student.  

• Must ensure that all Federal Student Aid applicant information (including federal 
tax information) is used for the application, award, and administration of financial 
aid to an applicant consistent with 20 U.S.C. §1090 and redisclosure 
requirements of FTI under 26 U.S.C. §6103(l)(13).  

• Must adhere to the strict confidentiality requirements when accessing FTI under 
26 U.S.C. §6103.  

• Must know the name of the Primary DPA and how to contact that individual.  
• Must protect all Federal Student Aid systems or other Federal agencies’ systems 

for the purposes of administering the HEA programs from access by or 
disclosure to unauthorized personnel.  

• Must protect all Federal Student Aid systems or other Federal agencies’ systems 
for the purposes of administering the HEA programs from access by or 
disclosure to unauthorized personnel.  

• Must report immediately to the Primary DPA any security incidents, potential 
threats, or vulnerabilities that involve Electronic Services.  

• Must report to the Primary DPA any compromise, suspected compromises, or 
incidents of sharing of a password or any other authenticator.  
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• Must protect all Federal Student Aid systems or other Federal agencies’ systems 
for the purposes of administering the HEA programs from access by or 
disclosure to unauthorized personnel.  

• Must report immediately to the Primary DPA any security incidents, potential 
threats, or vulnerabilities that involve Electronic Services.  

• Must report to the Primary DPA any compromise, suspected compromises, or 
incidents of sharing of a password or any other authenticator.  

• Must access only those systems, networks, data, control information, and 
software for which he or she is authorized.  

• Must ensure that all Electronic Services information is marked according to its 
sensitivity and is properly controlled and stored.  

• Must inform the organization’s Primary DPA the Electronic Services User no 
longer needs access to a Federal Student Aid system (i.e., the individual is 
leaving his or her position or his or her job responsibilities have changed).  

• Must not add code that might be harmful to the SAIG or Electronic Services.  
 
My signature below affirms that I have read this Statement and agree to abide by these 
rules.  
 
TG#__________ Electronic Services User’s Name _________________________________________________  
       (Print) 
Electronic Services User’s Job Title _____________________________________________________________ 
Phone # (____) __________________________ 
Electronic Services User’s Signature ______________________________________________   Date _________ 
 
Primary DPA Signature _________________________________________________________ Date _________ 
 
(This statement with an original signature [not a stamped signature] must be maintained by the Primary DPA.)  
 
NOTE: This statement, with an original signature, must be maintained by the Destination Point 
Administrator. DO NOT SEND THIS TO SAIG 
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